
Creating a Worksheet and 
an Embedded Chart 1

• Start and quit Excel

• Describe the Excel worksheet

• Enter text and numbers

• Use the Sum button to sum a range 
of cells

• Copy the contents of a cell to a 
range of cells using the fi ll handle

• Save a workbook

• Format cells in a worksheet

• Create a 3-D Clustered Column chart

• Change document properties

• Save a workbook a second time 
using the same fi le name

• Print a worksheet

• Open a workbook 

• Use the AutoCalculate area to 
determine statistics

• Correct errors on a worksheet

• Use Excel Help to answer questions

Microsoft Offi ce Excel 2007

Objectives
You will have mastered the material in this chapter when you can:
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What Is Microsoft Offi ce Excel 2007?
Microsoft Offi ce Excel 2007 is a powerful spreadsheet program that allows users to 
organize data, complete calculations, make decisions, graph data, develop professional 
looking reports (Figure 1–1), publish organized data to the Web, and access real-time data 
from Web sites. The four major parts of Excel are:

• Workbooks and Worksheets Workbooks are a collection of worksheets. 
Worksheets allow users to enter, calculate, manipulate, and analyze data such as 
numbers and text. The terms worksheet and spreadsheet are interchangeable. 

• Charts Excel can draw a variety of charts.
• Tables Tables organize and store data within worksheets. For example, once a user 

enters data into a worksheet, an Excel table can sort the data, search for specifi c data, 
and select data that satisfi es defi ned criteria.

• Web Support Web support allows users to save Excel worksheets or parts of a 
worksheet in HTML format, so a user can view and manipulate the worksheet using 
a browser. Excel Web support also provides access to real-time data, such as stock 
quotes, using Web queries.
This latest version of Excel makes it much easier than in previous versions to 

perform common functions by introducing a new style of user interface. It also offers the 
capability of creating larger worksheets, improved formatting and printing, improved 
charting and table functionality, industry-standard XML support that simplifi es the sharing 
of data within and outside an organization, improved business intelligence functionality, 
and the capability of performing complex tasks on a server.

In this chapter, you will create a worksheet that includes a chart. The data in the 
worksheet and chart includes sales data for several stores that a company owns and operates.

Microsoft Offi ce Excel 2007

1 Creating a Worksheet and 
an Embedded Chart 

EX 2

Project Planning 
Guidelines

The process of developing a worksheet that communicates specifi c information requires 
careful analysis and planning. As a starting point, establish why the worksheet is needed. 
Once the purpose is determined, analyze the intended users of the worksheet and their 
unique needs. Then, gather information about the topic and decide what to include in the 
worksheet. Finally, determine the worksheet design and style that will be most successful at 
delivering the message. Details of these guidelines are provided in Appendix A. In addi-
tion, each project developed in this book provides practical applications of these planning 
considerations.

Project — Worksheet with an Embedded Chart
The project in this chapter follows proper design guidelines and uses Excel to create the 
worksheet shown in Figure 1–1. The worksheet contains sales data for Walk and Rock 
Music stores. The Walk and Rock Music product line includes a variety of MP3 music 
players, called Rock-It MP3, including players that show pictures and video, as well as 
a complete line of headphones and other accessories. The company sells its products at 
kiosks in several malls throughout the United States. By concentrating its stores near 

C6160_EXC_01.4c.indd   2C6160_EXC_01.4c.indd   2 3/6/07   3:24:07 PM3/6/07   3:24:07 PM



colleges and universities and keeping the newest items in stock, the Walk and Rock 
Music stores quickly became trendy. As sales continued to grow in the past year, senior 
management requested an easy-to-read worksheet that shows product sales for the fi rst 
quarter by region. In addition, they asked for a chart showing fi rst quarter sales, because 
the president of the company likes to have a graphical representation of sales that allows 
him quickly to identify stronger and weaker product types by region. 

Microsoft Offi ce Excel 2007  

EX 3

Figure 1–1

The fi rst step in creating an effective worksheet is to make sure you understand 
what is required. The person or persons requesting the worksheet should supply their 
requirements in a requirements document. A requirements document includes a needs

data in worksheet

3-D Clustered 
Column chart
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Figure 1–2

requirements 
document

Overview
As you read this chapter, you will learn how to create the worksheet shown in 

Figure 1–1 by performing these general tasks:

• Enter text in the worksheet
• Add totals to the worksheet
• Save the workbook that contains the worksheet
• Format the text in the worksheet
• Insert a chart in the worksheet
• Save the workbook a second time using the same fi le name
• Print the worksheet

EX 4   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

statement, source of data, summary of calculations, and any other special requirements 
for the worksheet, such as charting and Web support. Figure 1–2 shows the requirements 
document for the new workbook to be created in this chapter.

General Project Guidelines
While creating an Excel worksheet, you need to make several decisions that will determine 
the appearance and characteristics of the fi nished worksheet. As you create the worksheet 
shown in Figure 1–1, you should follow these general guidelines:

1. Select titles and subtitles for the worksheet. Follow the less is more guideline. The less 
text in the titles and subtitles, the more impact the titles and subtitles will have. Use 
the fewest words possible to specify the information presented in the worksheet to the 
intended audience. 

(continued)

Plan
Ahead

Worksheet 
Development Cycle 
Spreadsheet specialists 
do not sit down and 
start entering text, 
formulas, and data into 
a blank Excel worksheet 
as soon as they have a 
spreadsheet assignment. 
Instead, they follow 
an organized plan, 
or methodology, that 
breaks the development 
cycle into a series of 
tasks. The recommended 
methodology for creating 
worksheets includes: 
(1) analyze require-
ments (supplied in a 
requirements document); 
(2) design solution; 
(3) validate design; 
(4) implement design; 
(5) test solution; and 
(6) document solution. 
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Excel 2007 Features 
With its what-if 
analysis tools, research 
capabilities, collaboration 
tools, streamlined user 
interface, smart tags, 
charting features, Web 
capabilities, hundreds of 
functions, and enhanced 
formatting capabilities, 
Excel 2007 is one of the 
easier and more powerful 
spreadsheet packages 
available. 
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(continued)

2. Determine the contents for rows and columns. Rows typically contain information that 
is analogous to items in a list, such as the products sold by a company. Columns typically 
contain descriptive information about items in rows or contain information that helps to 
group the data in the worksheet, such as company regions.

3. Determine the calculations that are needed. You can decide to total data in a variety of 
ways, such as across rows or in columns. You also can include a grand total.

4. Determine where to save the workbook. You can store a workbook permanently, or save 
it, on a variety of storage media including a hard disk, USB fl ash drive, or CD. You also 
can indicate a specifi c location on the storage media for saving the workbook.

5. Identify how to format various elements of the worksheet. The overall appearance of 
a worksheet signifi cantly affects its ability to communicate clearly. Examples of how you 
can modify the appearance, or format, of text include changing its shape, size, color, and 
position on the worksheet.

6. Decide on the type of chart needed. Excel includes the capability of creating many dif-
ferent types of charts, such as bar charts and pie charts. Each chart type relays a different 
message about the data in the worksheet. Choose a chart type that relays the message 
that you want to convey. 

7. Establish where to position and how to format the chart. The position and format of the 
chart should command the attention of the intended audience. If possible, position the 
chart so that it prints with the worksheet data on a single page.

When necessary, more specifi c details concerning the above guidelines are presented at 
appropriate points in the chapter. The chapter also will identify the actions performed and 
decisions made regarding these guidelines during the creation of the worksheet shown in 
Figure 1–1 on page EX 2.

Plan
Ahead 

Walk and Rock Music
First Quarter Rock-It MP3 Sales

Video
Mini
Micro
Flash
Accessories

Total

Northeast Southeast         Midwest South West

Legend of
Product Types

Northeast

$ 99,999.99

$999,999.99

Southeast

$ 99,999.99

$999,999.99

Midwest

$ 99,999.99

$999,999.99

South

$ 99,999.99

$999,999.99

West

$ 99,999.99

$999,999.99

Total

$ 99,999.99

$999,999.99

sketch of 
worksheet

Figure 1–3
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After carefully reviewing the requirements document (Figure 1–2 on page EX 4) and 
necessary decisions, the next step is to design a solution or draw a sketch of the worksheet 
based on the requirements, including titles, column and row headings, location of data 
values, and the 3-D Clustered Column chart, as shown in Figure 1–3 on page EX 5. The 
dollar signs, 9s, and commas that you see in the sketch of the worksheet indicate formatted 
numeric values.

 With a good understanding of the requirements document, an understanding of the 
necessary decisions, and a sketch of the worksheet, the next step is to use Excel to create 
the worksheet and chart.

Starting Excel
If you are using a computer to step through the project in this chapter and you want 
your screen to match the fi gures in this book, you should change your computer’s resolu-
tion to 1024 � 768. For information about how to change a computer’s resolution, read 
Appendix E.

To Start Excel

The following steps, which assume Windows is running, start Excel based on a typical installation of Microsoft 
Offi ce on your computer. You may need to ask your instructor how to start Excel for your computer.

1
• Click the Start button on the 

Windows taskbar to display the 
Start menu.

• Point to All Programs on the Start 
menu to display the All Programs 
submenu.

• Point to Microsoft Offi ce in the All 
Programs submenu to display the 
Microsoft Offi ce submenu 
(Figure 1–4).

Figure 1–4

Windows displays 
commands on the 
Start menu above 
the Start button

All Programs 
submenu 

Microsoft 
Offi ce 
submenu Microsoft Offi ce 

Excel 2007 
command

Windows 
taskbar

Microsoft 
Offi ce 
command

All Programs 
command

Start 
button
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2
• Click Microsoft Offi ce Excel 2007 

to start Excel and display a new 
blank workbook titled Book1 in the 
Excel window (Figure 1–5).

• If the Excel window is not maximized, 
click the Maximize button next to 
the Close button on its title bar to 
maximize the window. 

• If the worksheet window in Excel is 
not maximized, click the Maximize 
button next to the Close button 
on its title bar to maximize the 
worksheet window within Excel.

What is a maximized window? 

A maximized window fi lls the entire 
screen. When you maximize a 
window, the Maximize button 
changes to a Restore Down button. 
When you restore a maximized 
window, the window returns to its 
previous size and the Restore Down 
button changes to a Maximize button. 

Q
&

A
The Excel Workbook   EX 7

Figure 1–5 

mouse 
pointer

blank 
worksheet 

maximized 
Excel 
window

title of blank 
workbook is 
Book1

Maximize button 
changed to Restore 
Down button because 
window is maximized

title bar

Close button

Windows taskbar 
displays Microsoft 
Excel program 
button, indicating 
Excel is running

Other Ways
1. Double-click Excel 2007 

icon on desktop, if one 
is present

2. Click Microsoft Offi ce 
Excel 2007 on Start menu

The Excel Workbook
The Excel window consists of a variety of components to make your work more effi cient and 
worksheets more professional. These include the document window, Ribbon, Mini toolbar 
and shortcut menus, Quick Access Toolbar, and Offi ce Button. Some of these components are 
common to other Microsoft Offi ce 2007 programs; others are unique to Excel.

When Excel starts, it creates a new blank workbook, called Book1. The workbook 
(Figure 1–6) is like a notebook. Inside the workbook are sheets, each of which is called a 
worksheet. Excel opens a new workbook with three worksheets. 

If necessary, you can add additional worksheets as long as your computer has enough 
memory to accommodate them. Each worksheet has a sheet name that appears on a sheet 
tab at the bottom of the workbook. For example, Sheet1 is the name of the active worksheet 
displayed in the Book1 workbook. If you click the sheet tab labeled Sheet2, Excel displays 
the Sheet2 worksheet. The project in this chapter uses only the Sheet1 worksheet.

The Worksheet
The worksheet is organized into a rectangular grid containing vertical columns and 

horizontal rows. A column letter above the grid, also called the column heading, identifi es each 
column. A row number on the left side of the grid, also called the row heading, identifi es 

Excel Help 
Help with Excel is no 
further away than the 
Help button on the right 
side of the Ribbon. Click 
the Help button, type 
help in the ‘Type words 
to search for’ box, and 
then press the ENTER key. 
Excel responds with a list 
of topics you can click to 
learn about obtaining 
Help on any Excel-related 
topic. To fi nd out what is 
new in Excel 2007, type 
what is new in Excel in 
the ‘Type words to search 
for’ box.

B
T
W
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EX 8   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

each row. With the screen resolution set to 1024 � 768 and the Excel window maximized, 
Excel displays 15 columns (A through O) and 25 rows (1 through 25) of the worksheet on 
the screen, as shown in Figure 1–6.

Figure 1–6

Sheet 1 
worksheet

Name box 
with active 
cell reference 

worksheet 
window 

highlighted row 
and column 
headings indicate 
cell A1 is active 

heavy border 
surrounds 
active cell 

mouse 
pointer

cell D11 row 
heading 11 

mode 
indicator 

tab 
scrolling 
buttons 

status bar 

sheet tabs 

Microsoft Excel 
taskbar button 

tab split box 

scroll boxes 

view buttons; 
default is 
normal layout 

adjusts size 
of displayed 
document 

scroll bars 

scroll arrows 

gridlines 

column 
heading N 

The intersection of each column and row is a cell. A cell is the basic unit of a 
worksheet into which you enter data. Each worksheet in a workbook has 16,384 columns 
and 1,048,576 rows for a total of 17,179,869,180 cells. Only a small fraction of the active 
worksheet appears on the screen at one time.

A cell is referred to by its unique address, or cell reference, which is the coordinates 
of the intersection of a column and a row. To identify a cell, specify the column letter fi rst, 
followed by the row number. For example, cell reference D11 refers to the cell located at 
the intersection of column D and row 11 (Figure 1–6).

One cell on the worksheet, designated the active cell, is the one into which you can 
enter data. The active cell in Figure 1–6 is A1. The active cell is identifi ed in three ways. 
First, a heavy border surrounds the cell; second, the active cell reference shows immediately 
above column A in the Name box; and third, the column heading A and row heading 1 are 
highlighted so it is easy to see which cell is active (Figure 1–6).

The horizontal and vertical lines on the worksheet itself are called gridlines. 
Gridlines make it easier to see and identify each cell in the worksheet. If desired, you can 
turn the gridlines off so they do not show on the worksheet, but it is recommended that 
you leave them on for now.

The mouse pointer in Figure 1–6 has the shape of a block plus sign. The mouse pointer 
appears as a block plus sign whenever it is located in a cell on the worksheet. Another common 
shape of the mouse pointer is the block arrow. The mouse pointer turns into the block arrow 
whenever you move it outside the worksheet or when you drag cell contents between rows or 
columns. The other mouse pointer shapes are described when they appear on the screen.

number of  
worksheets available 
in workbook limited 
only by amount of 
memory on computer 

Worksheet 
Development 
The key to developing 
a useful worksheet is 
careful planning. Careful 
planning can reduce your 
effort signifi cantly and 
result in a worksheet 
that is accurate, easy 
to read, fl exible, and 
useful. When analyzing a 
problem and designing a 
worksheet solution, you 
should follow these steps: 
(1) defi ne the problem, 
including need, source 
of data, calculations, 
charting, and Web or 
special requirements; 
(2) design the worksheet; 
(3) enter the data and 
formulas; and (4) test the 
worksheet. 

B
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Worksheet Window
You view the portion of the worksheet displayed on the screen through a worksheet 
window (Figure 1–6). The default (preset) view is normal view. Below and to the right of 
the worksheet window are scroll bars, scroll arrows, and scroll boxes that you can use 
to move the worksheet window around to view different parts of the active worksheet. To 
the right of the sheet tabs at the bottom of the screen is the tab split box. You can drag the 
tab split box to increase or decrease the view of the sheet tabs (Figure 1–6). When you 
decrease the view of the sheet tabs, you increase the length of the horizontal scroll bar, 
and vice versa.

Status Bar
The status bar is located immediately above the Windows taskbar at the bottom 

of the screen (Figure 1–6). The status bar presents information about the worksheet, 
the function of the button the mouse pointer is pointing to, or the mode of Excel. Mode 
indicators, such as Enter and Ready, appear on the status bar and specify the current 
mode of Excel. When the mode is Ready, Excel is ready to accept the next command or 
data entry. When the mode indicator reads Enter, Excel is in the process of accepting 
data through the keyboard into the active cell.

Keyboard indicators, such as Scroll Lock, show which toggle keys are engaged. 
Keyboard indicators appear to the right of the mode indicator. Toward the right edge of 
the status bar are buttons and controls you can use to change the view of a document and 
adjust the size of the displayed document.

Ribbon
The Ribbon, located near the top of the Excel window, is the control center in 

Excel (Figure 1–7a). The Ribbon provides easy, central access to the tasks you perform 
while creating a worksheet. The Ribbon consists of tabs, groups, and commands. Each tab 
surrounds a collection of groups, and each group contains related commands.

Worksheet Window   EX 9

(a)  The Excel Ribbon

Name box 

Home tab formula bar top-level tabs 

Ribbon 

groups formula bar 
sizing handle 

formula bar 
expand button 

Figure 1–7

(b)  The Excel Ribbon Minimized

top-level tabs 

Ribbon
minimized 

The Worksheet Size 
and Window 
Excel’s 16,384 columns 
and 1,048,576 rows 
make for a huge 
worksheet that – if you 
could imagine – takes 
up the entire side of a 
building to display in its 
entirety. Your computer 
screen, by comparison, 
is a small window that 
allows you to view only 
a minute area of the 
worksheet at one time. 
While you cannot see the 
entire worksheet, you 
can move the window 
over the worksheet to 
view any part of it.

B
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Increasing the 
Viewing Area 
You can increase the size 
of the Excel window or 
viewing area to show 
more of the worksheet. 
Two ways exist to 
increase what you can 
see in the viewing area: 
(1) on the View tab on 
the Ribbon, click Full 
Screen; and (2) change 
to a higher resolution. 
See Appendix E for 
information about how 
to change to a higher 
resolution.

B
T
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EX 10   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

When you start Excel, the Ribbon displays seven top-level tabs: Home, Insert, Page 
Layout, Formulas, Data, Review, and View. The Home tab, called the primary tab, con-
tains groups with the more frequently used commands. To display a different tab on the 
Ribbon, click the top-level tab. That is, to display the Insert tab, click Insert on the Ribbon. 
To return to the Home tab, click Home on the Ribbon. The tab currently displayed is 
called the active tab.

To display more of the document in the document window, some users prefer to 
minimize the Ribbon, which hides the groups on the Ribbon and displays only the top-
level tabs (Figure 1–7b). To use commands on a minimized Ribbon, click the top-level tab.

Each time you start Excel, the Ribbon appears the same way it did the last time you 
used Excel. The chapters in this book, however, begin with the Ribbon appearing as it 
did at the initial installation of the software. If you are stepping through this chapter on a 
computer and you want your Ribbon to match the fi gures in this book, read Appendix E.

In addition to the top-level tabs, Excel displays other tabs, called contextual tabs, 
when you perform certain tasks or work with objects such as charts or tables. If you insert 
a chart in the worksheet, for example, the Chart Tools tab and its related subordinate 
Design tab appear (Figure 1–8). When you are fi nished working with the chart, the Chart 
Tools and Design tabs disappear from the Ribbon. Excel determines when contextual tabs 
should appear and disappear, based on the tasks you perform.

Figure 1–8

gallery scroll 
arrows contextual tab

More 
button

button

button 
arrowin-Ribbon 

gallery

Ribbon commands include buttons, boxes (text boxes, check boxes, etc.), and galleries 
(Figure 1–8). A gallery is a set of choices, often graphical, arranged in a grid or in a list. 
You can scroll through choices on an in-Ribbon gallery by clicking the gallery’s scroll 
arrows. An in-Ribbon gallery shows common gallery choices on the Ribbon rather than 
in a dropdown list. Or, you can click a gallery’s More button to view more gallery options 
on the screen at a time. Some buttons and boxes have arrows that, when clicked, also 
display a gallery; others always cause a gallery to be displayed when clicked. Most galleries 
support live preview, which is a feature that allows you to point to a gallery choice and 
see its effect in the worksheet without actually selecting the choice (Figure 1–9).

Minimizing the Ribbon 
If you want to minimize 
the Ribbon, right-click 
the Ribbon and then click 
Minimize the Ribbon 
on the shortcut menu, 
double-click the active 
tab, or press CTRL+F1. 
To restore a minimized 
Ribbon, right-click the 
Ribbon and then click 
Minimize the Ribbon 
on the shortcut menu, 
double-click any top-level 
tab, or press CTRL+F1. 
To use commands on a 
minimized Ribbon, click 
the top-level tab.

B
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Figure 1–10

image of clipboard 
helps to identify 
Paste button

mouse pointer 
on Paste 
button arrow

Enhanced 
ScreenTip for Paste 
button arrow

Figure 1–9

clicking Themes 
button displays 
gallery

as you move mouse 
pointer from one gallery 
option to next, Excel 
shows preview of style 
in document, so you can 
decide whether you want 
to select option

worksheet style changes 
to Foundry as you point to 
that style in the gallery

Figure 1–11

Clipboard 
task pane

clicking Dialog Box 
Launcher in Clipboard 
group displays 
Clipboard task pane 

clicking Dialog Box 
Launcher in Font group 
displays Format Cells 
dialog box

Format Cells 
dialog box

Some commands on the 
Ribbon display an image to help you 
remember their function. When you 
point to a command on the Ribbon, 
all or part of the command glows in 
shades of yellow and orange, and an 
Enhanced ScreenTip appears on the 
screen. An Enhanced ScreenTip 
is an on-screen note that provides 
the name of the command, available 
keyboard shortcut(s), a description 
of the command, and sometimes 
instructions for how to obtain Help 
about the command (Figure 1–10). 
Enhanced ScreenTips are more 
detailed than a typical ScreenTip, 
which usually displays only the name 
of the command.

The lower-right corner of 
some groups on the Ribbon has 
a small arrow, called a Dialog 
Box Launcher, that when clicked 
displays a dialog box or a task pane 
(Figure 1–11). A dialog box 
contains additional commands 
and options for the group. When 
presented with a dialog box, you 
make selections and must close the 
dialog box before returning to the 
worksheet. A task pane, by contrast, 
is a window that contains additional 
commands and can stay open and 
visible while you work on the worksheet. 
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Formula Bar
The formula bar appears below the Ribbon (Figure 1–12a). As you type, Excel displays 

the entry in the formula bar. You can make the formula bar larger by dragging the sizing 
handle (Figure 1–7) on the formula bar or clicking the expand button to the right of the 
formula bar. Excel also displays the active cell reference in the Name box on the left side 
of the formula bar.

Mini Toolbar and Shortcut Menus
The Mini toolbar, which appears automatically based on tasks you perform (such as 

selecting text), contains commands related to changing the appearance of text in a work-
sheet. All commands on the Mini toolbar also exist on the Ribbon. The purpose of the Mini 
toolbar is to minimize mouse movement. For example, if you want to format text using a 
command that currently is not displayed on the active tab, you can use the command on the 
Mini toolbar — instead of switching to a different tab to use the command.

When the Mini toolbar appears, it initially is transparent (Figure 1–12a). If you do not use 
the transparent Mini toolbar, it disappears from the screen. To use the Mini toolbar, move the 
mouse pointer into the toolbar, which causes the Mini toolbar to change from a transparent to 
bright appearance (Figure 1–12b).

Figure 1–12

(b) Bright Mini Toolbar

commands on 
Mini toolbar are 
also on Ribbon

bright
Mini toolbar

(a) Transparent Mini Toolbar

transparent 
Mini toolbar

Name box

formula bar sizing handle

Figure 1–13

right-clicked text

Mini toolbar

shortcut 
menu

A shortcut menu, which appears when you right-click 
an object, is a list of frequently used commands that relate 
to the right-clicked object. If you right-click an item in the 
document window such as a cell, Excel displays both the 
Mini toolbar and a shortcut menu (Figure 1–13).
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Quick Access Toolbar
The Quick Access Toolbar, located by default above the Ribbon, provides easy 

access to frequently used commands (Figure 1–14a). The commands on the Quick 
Access Toolbar always are available, regardless of the task you are performing. Initially, 
the Quick Access Toolbar contains the Save, Undo, and Redo buttons. If you click the 
Customize Quick Access Toolbar button, Excel provides a list of commands you quickly 
can add to and remove from the Quick Access Toolbar (Figure 1–14b).

You also can add other commands to or delete commands from the Quick Access 
Toolbar so that it contains the commands you use most often. As you add commands 
to the Quick Access Toolbar, its commands may interfere with the workbook title on 
the title bar. For this reason, Excel provides an option of displaying the Quick Access 
Toolbar below the Ribbon (Figure 1–14c). 

(a) Quick Access Toolbar above Ribbon

Save 
button

Undo 
button

Redo 
button Quick Access 

Toolbar positioned 
above Ribbon

(b) Customize Quick Access Toolbar Menu

Customize 
Quick Access 
Toolbar button

Customize 
Quick Access 
Toolbar menu

commands you 
quickly can add to 
or delete from Quick 
Access Toolbar

Figure 1–14

(c) Quick Access Toolbar below Ribbon

Quick Access 
Toolbar positioned 
below Ribbon

Each time you start Excel, the Quick Access Toolbar appears the same way it did the 
last time you used Excel. The chapters in this book, however, begin with the Quick Access 
Toolbar appearing as it did at the initial installation of the software. If you are stepping 
through this chapter on a computer and you want your Quick Access Toolbar to match 
the fi gures in this book, you should reset your Quick Access Toolbar. For more information 
about how to reset the Quick Access Toolbar, read Appendix E.

Quick Access Toolbar 
Commands 
To add a Ribbon 
command as a button to 
the Quick Access Toolbar, 
right-click the command 
on the Ribbon and then 
click Add to Quick Access 
Toolbar on the shortcut 
menu. To delete a button 
from the Quick Access 
Toolbar, right-click the 
button on the Quick 
Access Toolbar and then 
click Remove from Quick 
Access Toolbar on the 
shortcut menu. To display 
the Quick Access Toolbar 
below the Ribbon, 
right-click the Quick 
Access Toolbar and then 
click Show Quick Access 
Toolbar below the Ribbon 
on the shortcut menu.
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Figure 1–15

Offi ce Button

clicking command 
with no arrow to 
its right will display 
dialog box

Offi ce Button 
menu

list of recent Excel 
workbooks will 
appear here

Figure 1–16

submenu

pointing to command 
with arrow causes 
a submenu to be 
displayed

for commands that 
contain an arrow, 
pointing to command 
or to arrow causes 
submenu to be 
displayed

Offi ce Button
While the Ribbon is a control center for creating worksheets, the Offi ce Button is 

a central location for managing and sharing workbooks. When you click the Offi ce Button, 
located in the upper-left corner of the window, Excel displays the Offi ce Button menu 
(Figure 1–15). A menu contains a list of commands.

When you click the New, Open, Save As, and Print commands on the Offi ce 
Button menu, Excel displays a dialog box with additional options. The Save As, Print, 
Prepare, Send, and Publish commands have an arrow to their right. If you point to a 
button that includes an arrow, Excel displays a submenu, which is a list of additional 
commands associated with the selected command (Figure 1–16). For the Prepare, Send, 
and Publish commands that do not display a dialog box when clicked, you can point 
either to the command or the arrow to display the submenu.
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Key Tips
If you prefer using the keyboard, instead of the mouse, you can press the ALT key on 

the keyboard to display a Key Tip badge, or keyboard code icon, for certain commands 
(Figure 1–17). To select a command using the keyboard, press its displayed code letter, or 
Key Tip. When you press a Key Tip, additional Key Tips related to the selected com-
mand appear. For example, to select the New command on the Offi ce Button menu, press 
the ALT key, then press the F key, then press the N key. 

Figure 1–17

Key Tip badges 
appear when 
you press ALT 
key on keyboard

To remove the Key Tip badges from the screen, press the ALT key or the ESC key 
on the keyboard until all Key Tip badges disappear or click the mouse anywhere in the 
Excel window.

Selecting a Cell
To enter data into a cell, you fi rst must select it. The easiest way to select a cell (make 
it active) is to use the mouse to move the block plus sign mouse pointer to the cell and 
then click.

An alternative method is to use the arrow keys that are located just to the right of 
the typewriter keys on the keyboard. An arrow key selects the cell adjacent to the active 
cell in the direction of the arrow on the key.

You know a cell is selected, or active, when a heavy border surrounds the cell and the 
active cell reference appears in the Name box on the left side of the formula bar. Excel also 
changes the active cell’s column heading and row heading to a gold color.

Entering Text
In Excel, any set of characters containing a letter, hyphen (as in a telephone number), or 
space is considered text. Text is used to place titles, such as worksheet titles, column titles, 
and row titles, on the worksheet. 

Selecting a Cell 
You can select any cell 
by entering its cell 
reference, such as b4, in 
the Name box on the left 
side of the formula bar. 
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Determine the contents of rows and columns.
As previously mentioned, rows typically contain information that is similar to items in a list. 
For the Walk and Rock Music sales data, the list of product types meets this criterion. It is 
more likely that in the future, the company will add more product types as opposed to more 
regions. Each product type, therefore, should be placed in its own row. The row titles in 
column A (Video, Mini, Micro, Flash, Accessories, and Total) identify the numbers in each row.

Columns typically contain descriptive information about items in rows or contain 
information that helps to group the data in the worksheet. In the case of the Walk and 
Rock Music sales data, the regions classify the sales of each product type. The regions, 
therefore, are placed in columns. The column titles in row 3 (Northeast, Southeast, Midwest, 
South, West, and Total) identify the numbers in each column.

Plan
Ahead

Figure 1–18

row
titles

worksheet 
title

worksheet 
subtitle

column 
titles

Select titles and subtitles for the worksheet.
As previously stated, worksheet titles and subtitles should be as brief and meaningful as 
possible. As shown in Figure 1–18, the worksheet title, Walk and Rock Music, identifi es the 
company for whom the worksheet is being created in Chapter 1. The worksheet subtitle, 
First Quarter Rock-It MP3 Sales, identifi es the type of report. 

Plan
Ahead
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• Type Walk and Rock Music in cell 

A1, and then point to the Enter box 
in the formula bar.

Why did the appearance of the 
formula bar change? 

Excel displays the title in the 
formula bar and in cell A1. When 
you begin typing a cell entry, Excel 
displays two additional boxes in the 
formula bar: the Cancel box and the 
Enter box. Clicking the Enter box 
completes an entry. Clicking the 
Cancel box cancels an entry. 

What is the vertical line in cell A1? 

In Figure 1–20, the text in cell A1 is 
followed by the insertion point. The 
insertion point is a blinking vertical 
line that indicates where the next 
typed character will appear. 

Entering Text   EX 17

Figure 1–19

heavy border 
indicates cell 
A1 selected

insertion 
point

Enter box

ScreenTip identifi es 
box to which mouse 
pointer is pointing

text displayed in 
formula bar

text in active cell 
overfl ows into 
adjacent cells 
to right

Cancel box

Figure 1–20

Q
&

A
Q

&
A

To Enter the Worksheet Titles

The following steps show how to enter the worksheet titles in cells A1 and A2. Later in this chapter, the 
worksheet titles will be formatted so they appear as shown in Figure 1–18.

1
• Click cell A1 to make cell A1 the 

active cell (Figure 1–19).
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3
• Click the Enter box to complete the 

entry and enter the worksheet title 
in cell A1 (Figure 1–21).

Enter box and 
Cancel box no 
longer displayed

text 
entered 

Figure 1–22

worksheet 
subtitle entered 
into cell A2

4
• Click cell A2 to select it. 

• Type First Quarter Rock-It 
MP3 Sales as the cell entry. 

• Click the Enter box to complete 
the entry and enter the worksheet 
subtitle in cell A2 (Figure 1–22).

Other Ways

1. To complete entry, click 
any cell other than 
active cell

2. To complete entry, press 
ENTER key

3. To complete entry, press 
HOME, PAGE UP, PAGE 
DOWN, or END key

Entering Text in a Cell
When you complete a text entry into a cell, a series of events occurs. First, Excel 

positions the text left-aligned in the cell. Left-aligned means the cell entry is positioned 
at the far left in the cell. Therefore, the W in the worksheet title, Walk and Rock Music, 
begins in the leftmost position of cell A1.

Second, when the text is longer than the width of a column, Excel displays the 
overfl ow characters in adjacent cells to the right as long as these adjacent cells contain 
no data. In Figure 1–22, the width of cell A1 is approximately nine characters. The text 
consists of 19 characters. Therefore, Excel displays the overfl ow characters from cell A1 in 
cells B1 and C1, because cells B1 and C1 are empty. If cell B1 contained data, Excel would 
hide the overfl ow characters, so that only the fi rst nine characters in cell A1 would appear 

Figure 1–21
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Figure 1–23

active cell 
reference in 
Name box 
changes to B3

B3 is 
active cell

on the worksheet. Excel stores the overfl ow characters in cell A1 and displays them in the 
formula bar whenever cell A1 is the active cell.

Third, when you complete an entry by clicking the Enter box, the cell in which the 
text is entered remains the active cell.

Correcting a Mistake while Typing
If you type the wrong letter and notice the error before clicking the Enter box or 

pressing the ENTER key, use the BACKSPACE key to delete all the characters back to and 
including the incorrect letter. To cancel the entire entry before entering it into the cell, 
click the Cancel box in the formula bar or press the ESC key. If you see an error in a cell 
after entering the text, select the cell and retype the entry. Later in this chapter, addi-
tional error-correction techniques are discussed.

AutoCorrect
The AutoCorrect feature of Excel works behind the scenes, correcting common 

mistakes when you complete a text entry in a cell. AutoCorrect makes three types of 
corrections for you:

1. Corrects two initial capital letters by changing the second letter to lowercase.
2. Capitalizes the fi rst letter in the names of days.
3.  Replaces commonly misspelled words with their correct spelling. For example, 

it will change the misspelled word recieve to receive when you complete the entry. 
AutoCorrect will correct the spelling of hundreds of commonly misspelled words 
automatically.

To Enter Column Titles

To enter the column titles in row 3, select the appropriate cell and then enter the text. The following steps 
enter the column titles in row 3.

1
• Click cell B3 to make 

cell B3 the active cell 
(Figure 1–23).

The ENTER Key 
When you fi rst install 
Excel, the ENTER key not 
only completes the entry, 
but it also moves the 
selection to an adjacent 
cell. You can instruct 
Excel not to move the 
selection after pressing 
the ENTER key by clicking 
the Excel Options 
button on the Offi ce 
Button menu, clicking 
the Advanced option, 
removing the checkmark 
from the ‘After pressing 
Enter, move selection’ 
check box, and then 
clicking the OK button. 
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Figure 1–25

C3 is 
active cell

column 
title

Figure 1–24

Northeast 
displayed in 
formula bar 
and cell B3

2
• Type Northeast in cell B3 

(Figure 1–24).

3
• Press the RIGHT 

ARROW key to 
enter the column title, 
Northeast, in cell B3 
and make cell C3 
the active cell 
(Figure 1–25).

Why is the RIGHT 
ARROW key used to 
complete the entry in 
the cell? 

If the next entry is in 
an adjacent cell, use 
the arrow keys to 
complete the entry in a 
cell. When you press an 
arrow key to complete 
an entry, the adjacent 
cell in the direction of 
the arrow (up, down, 
left, or right) becomes 
the active cell. If the 
next entry is in a 
nonadjacent cell, complete an entry by clicking the next cell in which you plan to enter data. 
You also can click the Enter box or press the ENTER key and then click the appropriate cell for 
the next entry. 

Q
&

A
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1
• Click cell A4 to select it. 

• Type Video and then 
press the DOWN ARROW 
key to enter the row 
title and make cell A5 
the active cell 
(Figure 1–27).

Entering Text   EX 21

Figure 1–27

row title, Video,  
entered in cell A4

A5 is 
active cell

Figure 1–26

column titles 
left-aligned 
in cells

4
• Repeat Steps 2 and 3 to enter the 

remaining column titles in row 3; 
that is, enter Southeast in cell C3, 
Midwest in cell D3, South in cell E3, 
West in cell F3, and Total in cell G3 
(complete the last entry in cell G3 by 
clicking the Enter box in the formula 
bar) (Figure 1–26).

To Enter Row Titles

The next step in developing the worksheet for this project is to enter the row titles in column A. This process 
is similar to entering the column titles. The following steps enter the row titles in the worksheet.
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2
• Repeat Step 1 to enter the remaining 

row titles in column A; that is, enter 
Mini in cell A5, Micro in cell A6, 
Flash in cell A7, Accessories 
in cell A8, and Total in cell A9 
(Figure 1–28). 

Why is the text left-aligned in the cells? 

When you enter text, Excel 
automatically left-aligns the text in 
the cell. Excel treats any combination 
of numbers, spaces, and nonnumeric 
characters as text. For example, the 
following entries are text:

401AX21, 921-231, 619 321, 883XTY

You can change the text alignment 
in a cell by realigning it. Several 
alignment techniques are discussed 
later in the chapter. 

Figure 1–28

row titles 
left-aligned 
in cells

Entering Numbers
In Excel, you can enter numbers into cells to represent amounts. A number can contain 
only the following characters:

0 1 2 3 4 5 6 7 8 9 + - ( ) , / . $ % E e
If a cell entry contains any other keyboard character (including spaces), Excel 

interprets the entry as text and treats it accordingly. The use of the special characters is 
explained when they are used in this book.

Q
&

A

Numeric Limitations 
In Excel, a number can be 
between approximately 
–1 � 10308 and 1 � 10308,
that is, between a 
negative 1 followed by 
308 zeros and a positive 
1 followed by 308 zeros. 
To enter a number such 
as 6,000,000,000,000,000, 
you can type 
6,000,000,000,000,000, or 
you can type 6E15, which 
stands for 6 � 1015. 
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Table 1–1 Walk and Rock Music First Quarter Rock-It MP3 Sales 

Northeast Southeast Midwest South West

Video 66145.15 79677.10 34657.66 52517.20 99455.49

Mini 31375.24 82937.72 66137.50 30681.82 43595.24

Micro 27596.37 92716.32 88294.78 87984.79 83380.72

Flash 27885.59 98800.57 24111.33 69737.51 51003.09

Accessories   9715.12 31284.20 66527.37 40374.83 46321.88

The following steps enter the numbers in Table 1–1 one row at a time.

1
• Click cell B4.

• Type 66145.15 and then press the 
RIGHT ARROW key to enter the 
data in cell B4 and make cell C4 
the active cell (Figure 1–29).

Do I need to enter dollar signs, 
commas, or trailing zeros for the 
quarterly sales numbers?  

You are not required to type dollar 
signs, commas, or trailing zeros. 
When you enter a dollar value that 
has cents, however, you must add 
the decimal point and the numbers 
representing the cents. Later in this 
chapter, the numbers will be for-
matted to use dollar signs, commas, 
and trailing zeros to improve the appearance and readability of the numbers. 

Figure 1–29

66145.15 
entered 
in cell B4

C4 is 
active cell

2
• Enter 79677.1 in cell C4, 34657.66 

in cell D4, 52517.2 in cell E4, and 
99455.49 in cell F4 (Figure 1–30).

Figure 1–30

numbers 
right-aligned 
in cells

quarterly sales for 
Video product type 
entered in row 4

Q
&
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To Enter Numbers

The Walk and Rock Music First Quarter Rock-It MP3 Sales numbers used in Chapter 1 are summarized in 
Table 1–1. These numbers, which represent sales revenue for each of the product types and regions, must be entered 
in rows 4, 5, 6, 7, and 8. 
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data entered 
into worksheet

row title partially 
displayed because 
adjacent cell on 
right contains data

3
• Click cell B5. 

• Enter the remaining fi rst quarter 
sales numbers provided in Table 1–1 
for each of the four remaining 
offerings in rows 5, 6, 7, and 8 to 
display the quarterly sales in the 
worksheet  (Figure 1–31).

Figure 1–31

Calculating a Sum
The next step in creating the worksheet is to perform any necessary calculations, such as 
calculating the column and row totals. 

Determine calculations that are needed.
As stated in the requirements document in Figure 1–2 on page EX 4, totals are required for 
each region, each product type, and the company. The fi rst calculation is to determine the 
quarterly sales for the stores in the Northeast region in column B. To calculate this value 
in cell B9, Excel must add, or sum, the numbers in cells B4, B5, B6, B7, and B8. Excel’s SUM 
function, which adds all of the numbers in a range of cells, provides a convenient means to 
accomplish this task.

A range is a series of two or more adjacent cells in a column or row or a rectangular 
group of cells. For example, the group of adjacent cells B4, B5, B6, B7, and B8 is called a 
range. Many Excel operations, such as summing numbers, take place on a range of cells. 

After the total quarterly sales for the stores in the Northeast region in column B is 
determined, the totals for the remaining regions and totals for each product type will be 
determined.

Plan
Ahead

Entering Numbers 
as Text 
Sometimes, you will want 
Excel to treat numbers, 
such as Zip codes and 
telephone numbers, as 
text. To enter a number 
as text, start the entry 
with an apostrophe (‘).

B
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Calculating Sums 
Excel calculates sums for a 
variety of data types. For 
example, Boolean values, 
such as TRUE and FALSE, 
can be summed. Excel 
treats the value of TRUE 
as 1 and the value of 
FALSE as 0. Times also can 
be summed. For example, 
Excel treats the sum of 
1:15 and 2:45 as 4:00.

B
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2
• Click the Sum 

button on the Ribbon 
to display =SUM(B4:
B8) in the formula 
bar and in the active 
cell B9 (Figure 1–33).

How does Excel know 
which cells to sum? 

When you enter the 
SUM function using 
the Sum 
button, 
Excel auto-
matically 
selects what 
it considers to be your 
choice of the range 
to sum. When propos-
ing the range to sum, 
Excel fi rst looks for 
a range of cells with 
numbers above the 
active cell and then 
to the left. If Excel 
proposes the wrong 
range, you can correct 
it by dragging through 
the correct range before 
pressing the ENTER key. You also can enter the correct 
range by typing the beginning cell reference, a colon 
(:), and the ending cell reference. 

Calculating a Sum    EX 25

Figure 1–32

Sum button

B9 is 
active cell

Figure 1–33

SUM function 
in formula bar

B4:B8 in parentheses 
indicates range to 
be summed

proposed range to 
sum surrounded 
by moving border 
called marquee

ScreenTip

SUM function 
displayed in 
active cell

To Sum a Column of Numbers

The following steps sum the numbers in column B.

1
• Click cell B9 to make 

it the active cell and 
then point to the SUM 
button on the Ribbon 
(Figure 1–32). 

Home tab active

Q
&

A
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Figure 1–34

SUM function 
assigned to active 
cell B9 shows in 
formula bar

Sum 
button
arrow

sum of numbers 
in cells B4, B5, 
B6, B7, and B8

3
• Click the Enter box in 

the formula bar to 
enter the sum of the 
fi rst quarter sales for 
the fi ve product types 
for the Northeast 
region in cell B9.

• Select cell B9 to 
display the SUM 
function assigned to 
cell B9 in the formula 
bar (Figure 1–34).

What is the purpose 
of the Sum button 
arrow? 

If you click the Sum 
button arrow on the 
right side of the Sum 
button (Figure 1–34), 
Excel displays a list 
of often-used func-
tions from which you 
can choose. The list 
includes functions that 
allow you to deter-
mine the average, the 
number of items in the 
selected range, the minimum value, or the maximum value of a range of numbers. 

Other Ways

1. Click Function Wizard 
button in formula bar, 
select SUM in Select a 
function list, click OK 
button, select range, 
click OK button

2. Click Sum button arrow 
on Ribbon, click More 
Functions, select SUM 
in Select a function list, 
click OK button, select 
range, click OK button

3. Type = s in cell, 
select SUM from list, 
select range

4. Press ALT + EQUAL 
SIGN (=) twice

Using the Fill Handle to Copy a Cell to 
Adjacent Cells
Excel also must calculate the totals for the Southeast in cell C9, the Midwest in cell D9, 
the South in cell E9, and for the West in cell F9. Table 1–2 illustrates the similarities 
between the entry in cell B9 and the entries required to sum the totals in cells C9, D9, E9, 
and F9.

Table 1–2 Sum Function Entries in Row 9

Cell Sum Function Entries Remark

B9 =SUM(B4:B8) Sums cells B4, B5, B6, B7, and B8

C9 =SUM(C4:C8) Sums cells C4, C5, C6, C7, and C8

D9 =SUM(D4:D8) Sums cells D4, D5, D6, D7, and D8

E9 =SUM(E4:E8) Sums cells E4, E5, E6, E7, and E8

F9 =SUM(F4:F8) Sums cells F4, F5, F6, F7, and F8

Q
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A
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Figure 1–35

mouse pointer 
changes to cross 
hair indicating fi ll 
handle is selected

Figure 1–36

source area 
(cell B9) destination area 

(range C9:F9)

mouse 
pointer as dragging takes place, 

Excel displays border 
around destination area 
and source area

To place the SUM functions in cells C9, D9, E9, and F9, you could follow the same 
steps shown previously in Figures 1–32 through 1–34. A second, more effi cient method 
is to copy the SUM function from cell B9 to the range C9:F9. The cell being copied is 
called the source area or copy area. The range of cells receiving the copy is called the 
destination area or paste area.

Although the SUM function entries in Table 1–2 are similar, they are not exact 
copies. The range in each SUM function entry uses cell references that are one column 
to the right of the previous column. When you copy cell references, Excel automatically 
adjusts them for each new position, resulting in the SUM function entries illustrated in 
Table 1–2. Each adjusted cell reference is called a relative reference.

To Copy a Cell to Adjacent Cells in a Row

The easiest way to copy the SUM formula from cell B9 to cells C9, D9, E9, and F9 is to use the fi ll handle. 
The fi ll handle is the small black square located in the lower-right corner of the heavy border around the active cell. 
The following steps use the fi ll handle to copy cell B9 to the adjacent cells C9:F9.

1
• With cell B9 active, point to the fi ll 

handle (Figure 1–35).

2
• Drag the fi ll handle to select the 

destination area, range C9:F9, to 
display a shaded border around 
the destination area, range C9:F9, 
and the source area, cell B9 
(Figure 1–36). Do not release the 
mouse button.
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3
• Release the mouse button to copy the 

SUM function in cell B9 to the range 
C9:F9 (Figure 1–37) and calculate the 
sums in cells C9, D9, E9, and F9.

What is the purpose of the Auto Fill 
Options button? 

When you copy one range to another, 
Excel displays an Auto Fill Options 
button (Figure 1–37). The Auto Fill 
Options button allows you to choose 
whether you want to copy the values 
from the source area to the destina-
tion area with formatting, without 
formatting, or copy only the format. 
To view the available fi ll options, click 
the Auto Fill Options button. The 
Auto Fill Options button disappears 
when you begin another activity. 

Figure 1–38

mouse pointer is 
block plus sign

G4 is 
active cell

Figure 1–37

no transparent 
blue background 
for cell B9 because 
it is active cell

SUM function 
SUM(C4:C8) 
assigned to cell

SUM function 
SUM(D4:D8) 
assigned to cell

SUM function 
SUM(E4:E8) 
assigned to cell

SUM function 
SUM(F4:F8) 
assigned to cell

Auto Fill Options 
button remains on 
screen until you 
begin next activity

heavy border 
and transparent 
blue background 
indicate range B9:
F9 remains selected

Q
&

A

1. Select source area, click Copy 
button on Ribbon, select 
destination area, click Paste 
button on Ribbon

2. Right-click source area, click 
Copy on shortcut menu, 
right-click destination area, 
click Paste on shortcut menu

3. Select source area and then 
point to border of range; 
while holding down CTRL 
key, drag source area to 
destination area

Other Ways

To Determine Multiple Totals at the Same Time

The next step in building the worksheet is to determine the quarterly sales for each product type and total 
quarterly sales for the company in column G. To calculate these totals, you can use the SUM function much as it was 
used to total the quarterly sales by region in row 9. In this example, however, Excel will determine totals for all of 
the rows at the same time. The following steps illustrate this process.

1
• Click cell G4 to make it the active 

cell (Figure 1–38).
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3
• Click the Sum 

button on the Ribbon 
to calculate and 
display the sums of 
the corresponding 
rows of sales in cells 
G4, G5, G6, G7, G8, 
and G9 (Figure 1–40). 

4
• Select cell A10 to 

deselect the range 
G4:G9.

Why does Excel create 
totals for each row? 

If each cell in a selected 
range is next to a row 
of numbers, Excel 
assigns the SUM 
function to each cell when you click the Sum button. 

Saving the Project    EX 29

Figure 1–39

range 
G4:G9 
selected

Figure 1–40

Sum button

totals for each 
row of numbers

2
• With the mouse pointer in cell G4 

and in the shape of a block plus 
sign, drag the mouse pointer down 
to cell G9 to highlight the range 
G4:G9 with a transparent view 
(Figure 1–39).

Saving the Project
While you are building a worksheet in a workbook, the computer stores it in memory. 
When you save a workbook, the computer places it on a storage medium such as a USB 
fl ash drive, CD, or hard disk. A saved workbook is referred to as a fi le. A fi le name is 
the name assigned to a fi le when it is saved. It is important to save the workbook fre-
quently for the following reasons:

• The worksheet in memory will be lost if the computer is turned off or you lose 
electrical power while Excel is open.

• If you run out of time before completing your workbook, you may fi nish your 
worksheet at a future time without starting over.

Q
&

A

Saving 
Excel allows you to save 
a workbook in more than 
30 different fi le formats. 
Choose the fi le format by 
clicking the ‘Save as type’ 
box arrow at the bottom 
of the Save As dialog box 
(Figure 1–41 on the next 
page). Excel Workbook is 
the default fi le format.

B
T
W
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Figure 1–41

Save 
button

Save As 
dialog box

My Documents is default 
folder (your default 
folder may differ)

words in title text 
placeholder are 
displayed as default 
fi le name and are 
selected in File 
name text box

default fi le 
type is Excel 
Workbook

Determine where to save the workbook.
When saving a workbook, you must decide which storage medium to use.

• If you always work on the same computer and have no need to transport your projects to 
a different location, then your computer’s hard drive will suffi ce as a storage location. It 
is a good idea, however, to save a backup copy of your projects on a separate medium in 
case the fi le becomes corrupted or the computer’s hard drive fails.

• If you plan to work on your workbooks in various locations or on multiple computers, 
then you should save your workbooks on a portable medium, such as a USB fl ash drive 
or CD. The workbooks used in this book are saved to a USB fl ash drive, which saves fi les 
quickly and reliably and can be reused. CDs are easily portable and serve as good backups 
for the fi nal versions of workbooks because they generally can save fi les only one time.

Plan
Ahead

To Save a Workbook

You have performed many tasks while creating this project and do not want to risk losing the work completed 
thus far. Accordingly, you should save the workbook. The following steps save a workbook on a USB fl ash drive 
using the fi le name, Walk and Rock Music 1st Quarter Sales.

1
• With a USB fl ash drive 

connected to one 
of the computer’s 
USB ports, click the 
Save button on 
the Quick Access 
Toolbar to display the 
Save As dialog box 
(Figure 1–41).

Do I have to save to a 
USB fl ash drive? 

No. You can save to 
any device or folder. 
A folder is a specifi c 
location on a storage 
medium. You can save 
to the default folder 
or a different folder. 
You also can create 
your own folders, 
which is explained 
later in this book. 

Q
&

A
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Figure 1–42

selected words in default 
fi le name automatically 
are replaced when you 
type new fi le name

clicking Cancel 
button will 
close Save As 
dialog box

Figure 1–43

list of available 
drives and folders is 
displayed in Save in list

Save in 
box arrow

2
• Type Walk and Rock 
Music 1st Quarter 

Sales in the File name 
text box to change the 
fi le name. Do not press 
the ENTER key after 
typing the fi le name 
(Figure 1–42).

What characters can I 
use in a fi le name? 

A fi le name can have 
a maximum of 255 
characters, includ-
ing spaces. The only 
invalid characters are 
the backslash (\ ), slash 
(/), colon (:), asterisk 
(*), question mark (?), 
quotation mark (“), 
less than symbol (<), 
greater than symbol (>), 
and vertical bar (|). 

3
• Click the Save in box 

arrow to display a list 
of available drives and 
folders (Figure 1–43).

Why is my list of fi les, 
folders, and drives 
arranged and named 
differently from those 
shown in the fi gure? 

Your computer’s 
confi guration deter-
mines how the list 
of fi les and folders is 
displayed and how 
drives are named. You 
can change the save 
location by clicking 
shortcuts on the My 
Places bar. 

How do I save the fi le 
if I am not using a USB 
fl ash drive? 

Use the same process, 
but be certain to 
select your device in 
the Save in list. 

Q
&

A
Q

&
A

Q
&

A

shortcuts on My 
Places bar allow 
you to change 
save location

workbook to be 
saved on USB 
fl ash drive
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4
• Click UDISK 2.0 (E:) in 

the Save in list to select 
the USB fl ash drive, 
Drive E in this case, as 
the new save location 
(Figure 1–44).

What if my USB fl ash 
drive has a different 
name or letter? 

It is very likely that 
your USB fl ash drive 
will have a different 
name and drive letter 
and be connected to 
a different port. 

Figure 1–44

USB fl ash 
drive is new 
save location

Excel fi les currently 
saved on USB fl ash 
drive (Data Files 
for Students) are 
displayed

Save button

Figure 1–45

workbook name changed 
from Book1 to new fi le 
name, Walk and Rock 
Music 1st Quarter Sales

saved worksheet remains 
in memory and displayed 
on screen

Q
&

A

5
• Click the Save button in the Save As 

dialog box to save the workbook 
on the USB fl ash drive with the fi le 
name, Walk and Rock Music 
1st Quarter Sales (Figure 1–45).

How do I know that Excel saved the 
workbook? 

While Excel is saving your fi le, it 
briefl y displays a message on the 
status bar indicating the amount of 
the fi le saved. In addition, your USB 
drive may have a light that fl ashes 
during the save process. 

Q
&

A

Other Ways

1. Click Offi ce Button, click 
Save, type fi le name, 
select drive or folder, 
click Save button

2. Press CTRL+S or press 
SHIFT+F12, type fi le 
name, select drive or 
folder, click Save button
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Formatting the Worksheet
The text, numeric entries, and functions for the worksheet now are complete. The next 
step is to format the worksheet. You format a worksheet to emphasize certain entries and 
make the worksheet easier to read and understand.

Figure 1–46a shows the worksheet before formatting. Figure 1–46b shows the worksheet 
after formatting. As you can see from the two fi gures, a worksheet that is formatted not 
only is easier to read but also looks more professional.

(a) Before Formatting

(b) After Formatting

Figure 1–46
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Identify how to format various elements of the worksheet.
To change the unformatted worksheet in Figure 1–46a to the formatted worksheet in 
Figure 1–46b, the following tasks must be completed:

1. Change the font type, change the font style to bold, increase the font size, and change 
the font color of the worksheet titles in cells A1 and A2. These changes make the work-
sheet title prominently display to the user and inform the user of the purpose of the 
worksheet. 

2. Center the worksheet titles in cells A1 and A2 across columns A through G.

3. Format the body of the worksheet. The body of the worksheet, range A3:G9, includes the 
column titles, row titles, and numbers. Formatting the body of the worksheet changes 
the numbers to use a dollars-and-cents format, with dollar signs in the fi rst row (row 4) 
and the total row (row 9); adds underlining that emphasizes portions of the worksheet; 
and modifi es the column widths to make the text and numbers readable.

Plan
Ahead

The remainder of this section explains the process required to format the worksheet. 
Although the format procedures are explained in the order described above, you should 
be aware that you could make these format changes in any order. Modifying the column 
widths, however, usually is done last. 

Font Type, Style, Size, and Color
The characters that Excel displays on the screen are a specifi c font type, style, size, 

and color. The font type, or font face, defi nes the appearance and shape of the letters, 
numbers, and special characters. Examples of font types include Calibri, Cambria, Times 
New Roman, Arial, and Courier. Font style indicates how the characters are emphasized. 
Common font styles include regular, bold, underline, or italic. The font size specifi es the 
size of the characters on the screen. Font size is gauged by a measurement system called 
points. A single point is about 1/72 of one inch in height. Thus, a character with a point 
size of 10 is about 10/72 of one inch in height. The font color defi nes the color of the 
characters. Excel can display characters in a wide variety of colors, including black, red, 
orange, and blue.

When Excel begins, the preset font type for the entire workbook is Calibri, with a 
font size, font style, and font color of 11-point regular black. Excel allows you to change 
the font characteristics in a single cell, a range of cells, the entire worksheet, or the entire 
workbook.

Fonts and Themes 
Excel uses default 
recommended fonts 
based on the workbook’s 
theme. A theme is a 
collection of fonts and 
color schemes. The 
default theme is named 
Offi ce, and the two 
recommended fonts for 
the Offi ce theme are 
Calibri and Cambria. 
Excel, however, allows 
you to apply any font to 
a cell or range as long as 
the font is installed on 
your computer. 

B
T
W

Fonts 
In general, use no more 
than two font types in a 
worksheet.

B
T
W
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1
• Click cell A1 to make 

cell A1 the active cell.

• Click the Cell Styles 
button on the Ribbon 
to display the 
Cell Styles 
gallery 
(Figure 1–47). 

live preview of 
Title cell style 
in cell A1

Titles and 
Headings area

Title cell 
style

2
• Point to the Title cell 

style in the Titles and 
Headings area of the 
Cell Styles gallery to 
see a live preview of 
the cell style in cell A1 
(Figure 1–48). 

I Experiment

• Point to several other 
cell styles in the Cell 
Styles gallery to see a 
live preview of other 
cell styles in cell A1. 

Why does the font 
type, font size, and 
font color change in 
cell A1 when I point 
to it?

The change in cell A1 
is a result of live 
preview. Live preview 
is a feature of Excel 
2007 that allows you 
to preview cell styles 
as you point to them in the Cell 
Styles gallery. 

Figure 1–47

Cell Styles 
gallery

A1 is 
active cell

Cell Styles 
button

Figure 1–48

Q
&

A

To Change a Cell Style

Excel includes the capability of changing several characteristics of a cell, such as font type, font size, and font 
color, all at once by assigning a predefi ned cell style to a cell. The following steps assign the Title cell style to the 
worksheet title in cell A1.

Home tab 
active
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3
• Click the Title cell style 

to apply the cell style to 
cell A1 (Figure 1–49). 

Why do several items 
in the Font group on 
the Ribbon change? 

The changes to the 
Font box, Bold button, 
and Font Size box indi-
cate the font changes 
applied to the active 
cell, cell A1, as a result 
of applying the Title 
cell style. 

Figure 1–49

highlighted Bold 
button indicates 
bold font style 
selected

Cambria font 
type selected 
in Font box

font size 18 
selected in 
Font Size box

Title cell 
style applied 
to cell A1

To Change the Font Type

Different font types often are used in a worksheet to make it more appealing to the reader. The following 
steps show how to change the worksheet subtitle’s font type from Calibri to Cambria.

1
• Click cell A2 to make 

cell A2 the active cell.

• Click the Font box 
arrow on the Ribbon 
to display the Font 
gallery (Figure 1–50).

Which fonts are 
displayed in the Font 
gallery? 

Because many 
applications supply 
additional font types 
beyond what comes 
with the Windows 
operating system, the 
number of font types 
available on your 
computer will depend 
on the applications 
installed. This book 
uses only font types 
that come with the 
Windows operating system and Microsoft Offi ce. 

Q
&

A

Figure 1–50

Font box 
arrow

A2 is 
active cell

Font gallery

Q
&

A
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Figure 1–51

cell A2 displays 
live preview of 
Cambria font

Calibri font 
selected in the 
Font gallery

Theme 
Fonts area 

Cambria 
recommended 
for heading cells

Calibri 
recommended 
for body cells

2
• Point to Cambria in the Theme 

Fonts area of the Font gallery to see 
a live preview of the Cambria font 
in cell A2 (Figure 1–51). 

I Experiment

• Point to several other fonts in the 
Font gallery to see a live preview 
of other fonts in cell A2. 

What is the Theme Fonts area? 

Excel applies the same default 
theme to any new workbook that 
you start. A theme is a collection 
of cell styles and other styles that 
have common characteristics, such 
as a color scheme and font type. 
The default theme for an Excel 
workbook is the Offi ce theme. The 
Theme Fonts area of the Font gal-
lery includes the fonts included in 
the default Offi ce theme. Cambria 
is recommended for headings and 
Calibri is recommended for cells 
in the body of the worksheet 
(Figure 1–51). 

3
• Click Cambria in the Theme Fonts 

area to change the font type 
of the worksheet subtitle in 
cell A2 from Calibri to Cambria 
(Figure 1–52). 

font type in 
cell A2

Cambria font 
assigned to 
worksheet subtitle  
in cell A2

Figure 1–52

Other Ways

1. Select font type from 
Font list on Mini toolbar

2. Right-click cell, click 
Format Cells on shortcut 
menu, click Font tab, 
click desired font type, 
click OK button

Q
&

A
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1
• With cell A2 active, click the Bold 

button on the Ribbon to change the 
font style of the worksheet subtitle 
to bold (Figure 1–53).

What if a cell already includes a 
bold style? 

If you point to the Bold button and 
the active cell already is bold, then 
Excel displays the button with a 
transparent orange 
background. 

How do I remove 
the bold style from 
a cell? 

Clicking the Bold button a second 
time removes the bold font style. 

To Bold a Cell

You bold an entry in a cell to emphasize it or make it stand out from the rest of the worksheet. The following 
step shows how to bold the worksheet subtitle in cell A2.

Bold button changes 
to transparent orange 
background when 
active cell is bold

font style of 
worksheet 
subtitle in cell A2 
changed to bold

Figure 1–53

Q
&

A
Q

&
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1. Click Bold button on Mini 
toolbar

2. Right-click cell, click Format 
Cells on shortcut menu, 

click Font tab, click Bold, 
click OK button

3. Press CTRL+B

Other Ways

To Increase the Font Size of a Cell Entry

Increasing the font size is the next step in formatting the worksheet subtitle. You increase the font size of a cell so 
the entry stands out and is easier to read. The following steps increase the font size of the worksheet subtitle in cell A2.

1
• With cell A2 selected, click the Font 

Size box arrow on the Ribbon to 
display the Font Size list.

• Point to 14 in the Font Size list to 
see a live preview of cell A2 with a 
font size of 14 (Figure 1–54).

I Experiment

• Point to several other font sizes in 
the Font Size list to see 
a live preview of other 
font sizes in 
cell A2. 

Font Size 
box arrow

14 point

Font Size list

live preview 
of cell A2 with 
font size 14

Figure 1–54
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2
• Click 14 in the Font Size list to 

change the font in cell A2 from 
11 point to 14 point (Figure 1–55).

Can I assign a font size that is not in 
the Font Size list? 

Yes. An alternative to clicking a font 
size in the Font Size list is to click the 
Font Size box, type the font size, and 
then press the ENTER key. This proce-
dure allows you to assign a font size 
not available in the Font Size list to 
a selected cell entry. 

font in active cell 
A2 is 14-point 
Cambria bold

font changes 
from 11 point 
to 14 point

Figure 1–55

1. Click Increase Font Size 
button or Decrease Font 
Size button on Ribbon

2. Select font size from Font 
Size list on Mini toolbar

3. Right-click cell, click Format 
Cells on shortcut menu, 
click Font tab, select font 
size in Size box, click OK 
button

Other Ways

To Change the Font Color of a Cell Entry

The next step is to change the color of the font in cell A2 from black to dark blue. The following steps change 
the font color of a cell entry.

1
• With cell A2 selected, click the Font 

Color button arrow on the Ribbon to 
display the Font Color palette.

• Point to Dark Blue, Text 2 (dark blue 
color in column 4, row 1) in the 
Theme Colors area of the Font Color 
palette to see a live preview of the 
font color in cell A2 (Figure 1–56). 

I Experiment

• Point to several other colors in the 
Font Color palette to see a live preview 
of other font colors in cell A2. 

Which colors does Excel make 
available on the Font Color palette? 

You can choose from more than 60 different font colors on the Font Color palette (Figure 1–56). 
Your Font Color palette may have more or fewer colors, depending on color settings of your 
operating system. The Theme Colors area includes colors that are included in the current 
workbook’s theme. 

Font Color 
button arrow

Font Color 
palette

desired font 
color is dark blue 
(column 4, row 1)

live preview of  
font color in 
active cell A2 
is dark blue

Figure 1–56

Q
&

A
Q

&
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2
• Click Dark Blue, Text 2 (column 4, 

row 1) on the Font Color palette to 
change the font of the worksheet 
subtitle in cell A2 from black to 
dark blue (Figure 1–57).

Why does the Font Color button 
change after I select the new 
font color? 

When you choose a color on the 
Font Color palette, Excel changes 
the Font Color button on the 
Formatting toolbar to the chosen 
color. Thus, to change the font 
color of the cell entry in another 
cell to the same color, you need 
only to select the cell and then click the 
Font Color button. 

Font Color button 
changes to refl ect 
selected color

font color in 
active cell A2 
is dark blue

Figure 1–57

1. Select font color from Font 
Color list on Mini toolbar

2. Right-click cell, click Format 
Cells on shortcut menu, 
click Font tab, select color 
on Font Color palette, click 
OK button

Other Ways

To Center Cell Entries across Columns by Merging Cells

The fi nal step in formatting the worksheet title and subtitle is to center them across columns A through 
G. Centering a title across the columns used in the body of the worksheet improves the worksheet’s appearance. 
To do this, the seven cells in the range A1:G1 are combined, or merged, into a single cell that is the width of the 
columns in the body of the worksheet.  The seven cells in the range A2:G2 also are merged in a similar manner. 
Merging cells involves creating a single cell by combining two or more selected cells. The following steps center 
the worksheet title and subtitle across columns by merging cells.

Q
&

A

1
• Select cell A1 and then drag to cell 

G1 to highlight the range A1:G1 
(Figure 1–58).

What if a cell in the range B1:G1 
contained data? 

For the Merge and Center button 
to work properly, all the cells except 
the leftmost cell in the selected 
range must be empty. 

A1 is 
active cell

range 
A1:G1 
selected

Figure 1–58

Q
&

A
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2
• Click the Merge and Center button 

on the Ribbon to merge cells A1 
through G1 and center the contents of 
cell A1 across columns A through G 
(Figure 1–59). 

What happened to cells B1 
through G1? 

After the merge, cells B1 through G1 
no longer exist. Cell A1 now extends 
across columns A through G. 

Merge and 
Center button

cells A1 through 
G1 merged to 
create new cell A1

heavy border 
indicates new 
dimensions 
of cell A1

entry in cell 
A1 centered 
across columns 
A through G

A1 is 
active cell

Figure 1–59

Q
&

A

3
• Repeat Steps 1 and 2 

to merge and center 
the worksheet subtitle 
across cells A2 through 
G2 (Figure 1–60).

Are cells B1 through 
G1 and B2 through G2 
lost forever? 

No. The opposite of 
merging cells is splitting 
a merged cell. After 
you have merged 
multiple cells to create 
one merged cell, you 
can unmerge, or split, 
the merged cell to 
display the original cells 
on the worksheet. You 
split a merged cell by 
selecting it and clicking the Merge and Center button. For example, if you click the Merge and 
Center button a second time in Step 2, it will split the merged cell A1 to cells A1, B1, C1, D1, E1, 
F1, and G1. 

A2 is 
active cell

entry in cell 
A2 centered 
across columns 
A through G

cells A2 through 
G2 merged to 
create new cell A2

1. Right-click selection, click 
Merge and Center button 
on Mini toolbar

2. Right-click selection, click 
Format Cells on shortcut 
menu, click Alignment 
tab, select Center Across 
Selection in Horizontal list, 
click OK button

 Other Ways

Q
&

A

Figure 1–60

formats assigned 
to active cell A1

C6160_EXC_01.4c.indd   41C6160_EXC_01.4c.indd   41 3/6/07   3:25:35 PM3/6/07   3:25:35 PM



EX 42   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

To Format Column Titles and the Total Row

The next step to format the worksheet is to format the column titles in row 3 and the total row, row 9. Column 
titles and the total row should be formatted so anyone who views the worksheet can quickly distinguish the column 
titles and total row from the data in the body of the worksheet. The following steps format the column titles and total 
row using cell styles in the default worksheet theme.

1
• Click cell A3 and 

then drag the mouse 
pointer to cell G3 to 
select the range A3:G3.

• Point to the Cell Styles 
button on the Ribbon 
(Figure 1–61).

Why is cell A3 selected 
in the range for the 
column headings? 

The style to be applied 
to the column head-
ings includes an under-
line that will help to 
distinguish the column 
headings from the rest 
of the worksheet. Includ-
ing cell A3 in the range 
ensures that the cell will include the underline, which is visually appealing and further helps to 
separate the data in the worksheet. 

Cell Styles 
button

range 
A3:G3 
selected

Figure 1–61

Q
&

A

2
• Click the Cell Styles 

button to display the 
Cell Styles gallery.

• Point to the 
Heading 3 cell style 
in the Titles and 
Headings area of the 
Cell Styles gallery to 
see a live preview of 
the cell style in the 
range A3:G3 
(Figure 1–62).

I Experiment

• Point to other cell 
styles in the Titles and 
Headings area of the 
Cell Styles gallery to 
see a live preview of 
other cell styles in the 
range A3:G3. 

live preview 
of Heading 
3 cell style in 
range A3:G3

Titles and 
Headings area

Heading 3 
cell style

Total cell 
style

Figure 1–62
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3
• Click the Heading 3 cell style to 

apply the cell style to the range 
A3:G3.

• Click cell A9 and then drag the 
mouse pointer to cell G9 to select 
the range A9:G9.

• Point to the Cell Styles button on 
the Ribbon (Figure 1–63).

Why should I choose Heading 3 
instead of another heading 
cell style? 

Excel includes many types of 
headings, such as Heading 1 and 
Heading 2, because worksheets 
often include many levels of head-
ings above columns. In the case of 
the worksheet created for this proj-
ect, the Heading 3 title includes 
formatting that makes the column 
titles’ font size smaller than the 
title and subtitle and makes the 
column title stand out from the 
data in the body of the worksheet. 

Cell Styles 
button

Heading 3 cell 
style applied to 
range A3:G3

range 
A9:G9 
selected

Figure 1–63

Q
&

A

4
• Click the Cell Styles button on the 

Ribbon to display the Cell Styles gal-
lery and then click the Total cell style 
in the Titles and Headings area to 
apply the Total cell style to the cells 
in the range A9:G9.

• Click cell A11 to select the cell 
(Figure 1–64).

Total cell style 
applied to 
range A9:G9 

A11 is 
active cell

Figure 1–64
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To Format Numbers in the Worksheet

As previously noted, the numbers in the worksheet should be formatted to use a dollar-and-cents format, with 
dollar signs in the fi rst row (row 4) and the total row (row 9). Excel allows you to format numbers in a variety of 
ways, and these methods are discussed in other chapters in this book. The following steps use buttons on the Ribbon 
to format the numbers in the worksheet.

1
• Select cell B4 and drag 

the mouse pointer to 
cell G4 to select the 
range B4:G4.

• Point to the 
Accounting Number 
Format button on the 
Ribbon to display the 
Enhanced ScreenTip 
(Figure 1–65).

Accounting Number 
Format button

Enhanced 
ScreenTip 

Figure 1–65

2
• Click the Accounting Number Format 

button on the Ribbon to apply the 
Accounting Number Format to the 
cells in the range B4:G4.

• Select the range B5:G8 (Figure 1–66). 

What effect does the Accounting 
Number Format have on the 
selected cells? 

The Accounting Number Format 
causes the cells to display with two 
decimal places so that decimal places 
in cells below the selected cells align 
vertically. Cell widths are automati-
cally adjusted to accommodate the 
new formatting. 

range 
B5:G8 
selected

cell widths automatically 
adjusted to accommodate 
new formatting

Figure 1–66

Q
&

A

Accounting Number 
Format applied to 
range B4:G4

range 
B4:G4 
selected
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3
• Click the Comma Style 

button on the Ribbon 
to apply the Comma 
Style to the range 
B5:G8.

• Select the range B9:G9 
(Figure 1–67).

What effect does 
the Comma Style 
format have on the 
selected cells? 

The Comma Style 
format causes the cells 
to display with two 
decimal places and 
commas as thousands 
separators. 

range 
B9:G9 
selectedQ

&
A

4
• Click the Accounting 

Number Format but-
ton on the Ribbon to 
apply the Accounting 
Number format to the 
cells in the range 
B9:G9.

• Select cell A11 
(Figure 1-68). 

Accounting Number 
format applied to 
range B9:G9

A11 is 
active cell

Figure 1–68

1. Click Accounting Number 
Format or Comma button 
on Mini toolbar

2. Right-click selection, click 
Format Cells on the shortcut 
menu, select Accounting 
in Category list or select 
Number and click Use 1000 
Separator, click OK button

Other Ways

Comma 
Style 
button

Figure 1–67

Accounting Number 
Format button

Comma Style 
format applied to 
range B5:G8
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To Adjust the Column Width

The last step in formatting the worksheet is to adjust the width of column A so that the word Accessories in 
cell A8 is shown in its entirety in the cell. Excel includes several methods for adjusting cell widths and row heights, 
and these methods are discussed later in this book. The following steps adjust the width of column A so that the 
contents of cell A8 are displayed in the cell.

1
• Point to the boundary on the right 

side of the column A heading above 
row 1 to change the mouse pointer 
to a split double arrow (Figure 1–69).

mouse pointer 
is split double 
arrow

current right 
border of 
column A 

Figure 1–69

2
• Double-click on the boundary to 

adjust the width of column A to 
the width of the largest item in the 
column (Figure 1–70).

What if none of the items in column 
A extended through the entire 
width of the column? 

If all of the items in column A were 
shorter in length than the width of 
the column when you double-click 
the right side of the column A head-
ing, then Excel still would adjust the 
column width to the largest item 
in the column. That is, Excel would 
reduce the width of the column to 
the largest item. 

mouse 
pointer

new column 
A width

Figure 1–70

Q
&

A
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Using the Name Box to Select a Cell
The next step is to chart the quarterly sales for the fi ve product types sold by the company. 
To create the chart, you must select the cell in the upper-left corner of the range to chart 
(cell A3). Rather than clicking cell A3 to select it, the next section describes how to use the 
Name box to select the cell. 

To Use the Name Box to Select a Cell

As previously noted, the Name box is located on the left side of the formula bar. 
To select any cell, click the Name box and enter the cell reference of the cell you want to 
select. The following steps select cell A3.

1
• Click the Name box 

in the formula bar 
and then type a3 
as the cell to select 
(Figure 1–71).

Why is cell A11 still 
selected? 

Even though cell A11 
is the active cell, Excel 
displays the typed cell 
reference a3 in the 
Name box until you 
press the ENTER key. 

Figure 1–72

A3 is 
active cell

a3 typed in 
Name box

A11 is 
active cell

Figure 1–71

Q
&

A

2  
• Press the ENTER key to 

change the active cell 
from A11 to cell A3 
(Figure 1–72).
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Other Ways to Select Cells
As you will see in later chapters, in addition to using the Name box to select any 

cell in a worksheet, you also can use it to assign names to a cell or range of cells. Excel 
supports several additional ways to select a cell, as summarized in Table 1–3. 

Table 1–3 Selecting Cells in Excel

Key, Box, or Command Function

ALT+PAGE DOWN Selects the cell one worksheet window to the right and moves the worksheet 
window accordingly.

ALT+PAGE UP Selects the cell one worksheet window to the left and moves the worksheet 
window accordingly.

ARROW Selects the adjacent cell in the direction of the arrow on the key.

CTRL+ARROW Selects the border cell of the worksheet in combination with the arrow keys 
and moves the worksheet window accordingly. For example, to select the 
rightmost cell in the row that contains the active cell, press CTRL+RIGHT ARROW. 
You also can press the END key, release it, and then press the appropriate 
arrow key to accomplish the same task.

CTRL+HOME Selects cell A1 or the cell one column and one row below and to the right of 
frozen titles and moves the worksheet window accordingly.

Find command on Edit menu or 
SHIFT+F5

Finds and selects a cell that contains specifi c contents that you enter in the 
Find dialog box. If necessary, Excel moves the worksheet window to display 
the cell. You also can press CTRL+F to display the Find dialog box.

Go To command on Edit menu 
or F5

Selects the cell that corresponds to the cell reference you enter in the Go To 
dialog box and moves the worksheet window accordingly. You also can press 
CTRL+G to display the Go To dialog box.

HOME Selects the cell at the beginning of the row that contains the active cell and 
moves the worksheet window accordingly. 

Name box Selects the cell in the workbook that corresponds to the cell reference you 
enter in the Name box.

PAGE DOWN Selects the cell down one worksheet window from the active cell and moves 
the worksheet window accordingly.

PAGE UP Selects the cell up one worksheet window from the active cell and moves the 
worksheet window accordingly.

Decide on the type of chart needed.
Excel includes 11 chart types from which you can choose including column, line, pie, bar, 
area, X Y (scatter), stock, surface, doughnut, bubble, and radar. The type of chart you choose 
depends on the type of data that you have, how much data you have, and the message you 
want to convey. 

A column chart is a good way to compare values side-by-side. A Clustered Column chart 
can go even further in comparing values across categories. In the case of the Walk and Rock 
Music quarterly sales data, comparisons of product types within each region can be made 
side-by-side with a Clustered Column chart. 

Establish where to position and how to format the chart.

• When possible, try to position charts so that both the data and chart appear on the 
screen on the worksheet together and so that the data and chart can be printed in the 
most readable manner possible. By placing the chart below the data on the Walk and 
Rock Music 1st Quarter Sales worksheet, both of these goals are accomplished. 

• When choosing/selecting colors for a chart, consider the color scheme of the rest of the 
worksheet. The chart should not present colors that are in stark contrast to the rest of the 
worksheet. If the chart will be printed in color, minimize the amount of dark colors on 
the chart so that the chart both prints quickly and preserves ink. 

Plan 
Ahead

Find & Select 
You can fi nd and select 
cells based on their 
content. Click the Find 
& Select button on the 
Home tab on the Ribbon. 
Then, click the Go To 
Special command. Choose 
your desired option in 
the Select area of the Go 
To Special dialog box and 
then click the OK button.

B
T
W
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columns developed 
from values in 
worksheet

chart scale 
along y-axis

dash 
represents 0

3-D Clustered 
Column chart

each color represents 
a row (product type) 
in worksheet

Figure 1–73

The chart uses different colored columns to represent sales for different product 
types. Each region uses the same color scheme for identifying product types, which allows 
for easy identifi cation and comparison. For the Northeast sales region, for example, the 
dark blue column representing Video products shows quarterly sales of $66,145.15; for 
the Southeast sales region, the maroon column representing Mini products shows quar-
terly sales of $82,937.72; for the Midwest sales region, the pale green column represent-
ing Micro products shows quarterly sales of $88,294.78; for the South sales region, the 
violet column representing Flash products shows quarterly sales of $69,737.51; and for 
the West sales region, the light blue column representing Accessories shows quarterly 
sales of $46,321.88. Because the same color scheme is used in each region to represent the 
fi ve product types, you easily can compare sales of product types among the sales regions. 
The totals from the worksheet are not represented, because the totals are not in the range 
specifi ed for charting.

Adding a 3-D Clustered Column Chart to 
the Worksheet
As outlined in the requirements document in Figure 1–2 on page EX 4, the worksheet 
should include a 3-D Clustered Column chart to graphically represent quarterly sales for 
each product type that the company sells. The 3-D Clustered Column chart shown in 
Figure 1–73 is called an embedded chart because it is drawn on the same worksheet as 
the data. 

Cell Values and 
Charting 
When you change a cell 
value on which a chart is 
dependent, Excel redraws 
the chart instantaneously, 
unless automatic 
recalculation is disabled. 
If automatic recalculation 
is disabled, then you 
must press the F9 key 
to redraw the chart. 
To enable or disable 
automatic recalculation, 
click the Calculations 
Options button on the 
Formulas tab on the 
Ribbon.

B
T
W
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Excel derives the chart scale based on the values in the worksheet and then displays 
the scale along the vertical axis (also called the y-axis or value axis) of the chart. For 
example, no value in the range B4:F8 is less than 0 or greater than $100,000.00, so the 
scale ranges from 0 to $100,000.00. Excel also determines the $10,000.00 increments of 
the scale automatically. For the numbers along the y-axis, Excel uses a format that includes 
representing the 0 value with a dash (Figure 1–73 on the previous page).

To Add a 3-D Clustered Column Chart to the Worksheet

The commands to insert a chart are located on the Insert tab. With the range to chart selected, you click the 
Column button on the Ribbon to initiate drawing the chart. The area on the worksheet where the chart appears is 
called the chart location. As shown in Figure 1–73, the chart location in this worksheet is the range A11:G22, imme-
diately below the worksheet data.

The following steps draw a 3-D Clustered Column chart that compares the quarterly sales by product type for 
the fi ve sales regions. 

1  
• Click cell A3 and 

then drag the mouse 
pointer to the cell F8 
to select the range 
A3:F8 (Figure 1–74).

Figure 1–74

range 
A3:F8 
selected
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2
• Click the Insert tab to 

make the Insert tab 
the active tab 
(Figure 1–75).

What tasks can I 
perform with the 
Insert tab? 

The Insert tab includes 
commands that allow 
you to insert various 
objects, such as shapes, 
tables, illustrations, and 
charts, into a work-
sheet. These objects 
will be discussed as they 
are used throughout 
this book. 

Figure 1–75

Insert tab 
groups and 
commands

3
• Click the Column 

button on the Ribbon 
to display the Column 
gallery.

• Point to the 3-D 
Clustered Column 
chart type in the 3-D 
Column area of the 
Column gallery 
(Figure 1–76).

Figure 1–76

Column 
button

Column 
gallery

3-D Clustered 
Column chart type

Enhanced 
ScreenTip 

3-D 
Column 
area

Q
&

A

Insert tab 
becomes 
active tab
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4
• Click the 3-D Clustered Column 

chart type in the 3-D Column area 
of the Column gallery to add a 
3-D Clustered Column chart to the 
middle of the worksheet in 
a selection rectangle.

• Click the top-right edge of the 
selection rectangle but do not 
release the mouse to grab the chart 
and change the mouse pointer to 
a cross hair with four arrowheads 
(Figure 1–77).

Why is a new tab displayed on the 
Ribbon? 

When you select objects such as 
shapes or charts, Excel displays 
contextual tabs that include special 
commands that are used to work 
with the type of object selected. 
Because a chart is selected, Excel 
displays the Chart Tools contextual 
tab. The three tabs below the Chart 
Tools contextual tab, Design, Layout, 
and Format, are tabs that include 
commands to work with charts. 

Figure 1–77

Design tab

mouse pointer 
changes to cross hair 
with four arrowheads

initial 3-D 
Clustered 
Column chart

selection 
rectangle

sizing 
handles

when chart is 
selected, colored 
borders in worksheet 
indicate chart range

Chart Tools 
contextual tab

Q
&

A

5
• Continue holding down the left 

mouse button while dragging 
the chart down and to the left 
to position the upper-left corner 
of the dotted line rectangle over 
the upper-left corner of cell A11. 
Release the mouse button to com-
plete the move of the chart. 

• Click the middle sizing handle on 
the right edge of the chart and 
do not release the mouse button 
(Figure 1–78).

How does Excel know how to create 
the chart? 

Excel automatically selects the 
entries in the topmost row of the 
chart range (row 3) as the titles for 
the horizontal axis (also called the 
x-axis or category axis) and draws 
a column for each of the 25 cells in 
the range containing numbers. 

Figure 1–78

upper-left corner of 
chart area moved to 
upper-left corner of 
cell A11

mouse pointer changes 
to a cross hair

Q
&

A

C6160_EXC_01.4c.indd   52C6160_EXC_01.4c.indd   52 3/6/07   3:25:59 PM3/6/07   3:25:59 PM



Ex
ce

l 
C

h
ap

te
r 

1Adding a 3-D Clustered Column Chart to the Worksheet   EX 53

6
• While continuing to 

hold down the mouse 
button, press the ALT 
key and drag the right 
edge of the chart to the 
right edge of column 
G and then release the 
mouse button to resize 
the chart.

• Point to the middle 
sizing handle on the 
bottom edge of the 
selection rectangle and 
do not release 
the mouse button 
(Figure 1–79).

Why should I hold the 
ALT key down while I 
resize a chart? 

Holding down the ALT 
key while you drag a 
chart snaps (aligns) the 
edge of the chart area 
to the worksheet grid-
lines. If you do not hold 
down the ALT key, then 
you can place an edge of a 
chart in the middle of a column or row. 

Figure 1–79

Chart Styles gallery 
More button

chart resized so that 
right edge of chart 
aligns with right 
edge of column G

mouse pointer changes 
to a cross hair

7
• While continuing to 

hold down the mouse 
button, press the ALT 
key and drag the bot-
tom edge of the chart 
up to the bottom edge 
of row 22 and then 
release the mouse 
button to resize 
the chart. 

• Click the More button 
in the Chart Styles 
gallery to expand the 
gallery and point to 
Style 2 in the gallery 
(column 2, row 1) 
(Figure 1–80).

Q
&

A

Figure 1–80

Style 2 
chart style

Chart Styles 
gallery

chart resized so that bottom 
edge of chart aligns with 
bottom edge of row 22
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8

• Click Style 2 in the Chart Styles 
gallery to apply the chart style 
Style 2 to the chart.

I Experiment

• Select other chart styles in the 
Chart Styles gallery to apply other 
chart styles to the chart, but select 
Style 2 as your fi nal choice.  

• Click cell I9 to deselect the chart 
and complete the worksheet 
(Figure 1–81).

What is the purpose of the items 
on the right side of the chart? 

The items to the right of the 
column chart in Figure 1–81 are 
the legend, which identifi es the 
colors assigned to each bar in the 
chart. Excel automatically selects 
the entries in the leftmost column 
of the chart range (column A) as 
titles within the legend. 

Figure 1–81

Home tab is active tab and 
Chart Tools contextual tab 
and related tabs disappear

I9 is 
active cell

legend defi nes 
columns in 
chart area

Style 2 chart style 
applied to chart

Q
&

A

Changing Document Properties and Saving Again
Excel helps you organize and identify your fi les by using document properties, which are 
the details about a fi le. Document properties, also known as metadata, can include such 
information as the project author, title, or subject. Keywords are words or phrases that 
further describe the document. For example, a class name or worksheet topic can describe 
the fi le’s purpose or content. Document properties are valuable for a variety of reasons:

• Users can save time locating a particular fi le because they can view a document’s 
properties without opening the workbook.

• By creating consistent properties for fi les having similar content, users can better 
organize their workbooks.

• Some organizations require Excel users to add document properties so that other 
employees can view details about these fi les.
Five different types of document properties exist, but the more common ones used 

in this book are standard and automatically updated properties. Standard properties 
are associated with all Microsoft Offi ce documents and include author, title, and subject. 
Automatically updated properties include fi le system properties, such as the date you 
create or change a fi le, and statistics, such as the fi le size.

Document Properties 
Excel allows you to assign 
additional document 
properties by clicking 
the Document Properties 
button arrow in the 
Document Information 
panel and then clicking 
Advanced Properties. 
You can assign custom 
properties, such as 
Department, Purpose, 
and Editor. Or, you 
can create your own 
document properties. 

B
T
W
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To Change Document Properties

The Document Information Panel contains areas where you can view and enter document properties. You 
can view and change information in this panel at any time while you are creating your workbook. Before saving the 
workbook again, you want to add your name and class name as document properties. The following steps use the 
Document Information Panel to change document properties.

1
• Click the Offi ce Button 

to display the Offi ce 
Button menu.

• Point to Prepare on 
the Offi ce Button 
menu to display the 
Prepare submenu  
(Figure 1–82).

What other types of 
actions besides chang-
ing properties can you 
take to prepare 
a document for 
distribution? 

The Prepare submenu 
provides commands 
related to sharing 
a document with 
others, such as 
allowing or restrict-
ing people to view 
and modify your document, checking to see if your worksheet will work in earlier versions of 
Excel, and searching for hidden personal information. 

Figure 1–82

Offi ce Button

clicking Properties 
command will 
open Document 
Information Panel

Prepare submenu displays list 
of tasks that can be used to 
prepare fi les for distribution

Offi ce Button 
menu

Prepare 
command

2
• Click Properties on the 

Prepare submenu to 
display the Document 
Information Panel 
(Figure 1–83).

Why are some of the 
document properties 
in my Document 
Information Panel 
already fi lled in? 

The person who 
installed Microsoft 
Offi ce 2007 on your 
computer or network 
may have set or 
customized the 
properties. 

Q
&

A

Figure 1–83

Document Information 
Panel is displayed at 
top of document

Q
&

A

student name 
will be typed in 
Author text box 

course number and 
section will be typed 
in Subject text box
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3
• Click the Author text 

box and then type 
your name as the 
Author property. If a 
name already is dis-
played in the Author 
text box, delete 
it before typing 
your name.

• Click the Subject text 
box, if necessary delete 
any existing text, and 
then type your course 
and section as the 
Subject property.

• Click the Keywords 
text box, if necessary 
delete any existing 
text, and then type 
First Quarter 

Rock-It MP3 Sales 
(Figure 1-84).

What types of 
document proper-
ties does Excel collect 
automatically? 

Excel records such details as how long you worked at creating your project, how many times 
you revised the document, and what fonts and themes are used. 

Figure 1–84

keywords 
entered

course and 
section entered

Close the 
Document 
Information 
Panel button

4
• Click the Close the Document Information Panel button so that the Document Information 

Panel no longer is displayed.

Q
&

A

To Save an Existing Workbook with the Same File Name

Saving frequently cannot be overemphasized. Several modifi cations have been made to the workbook since it 
was saved earlier in the chapter. Earlier in this chapter, the Save button on the Quick Access Toolbar caused the Save 
As dialog box to appear, and the fi le name, Walk and Rock Music 1st Quarter Sales, was entered. Clicking the Save 
button on the Quick Access Toolbar causes Excel to save the changes made to the workbook since the last time it 
was saved. The following step saves the workbook again.

student name 
entered
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1
• With your USB fl ash drive connected 

to one of the computer’s USB ports, 
click the Save button on the Quick 
Access Toolbar to overwrite the 
previous Walk and Rock Music 
1st Quarter Sales fi le on the USB 
fl ash drive (Figure 1–85).

Why did the Save As dialog box 
not appear? 

Excel overwrites the document 
using the settings specifi ed the 
fi rst time the document was saved. 
To save the fi le with a different 
fi le name or on different media, 
display the Save As dialog box by 
clicking the Offi ce Button and then 
clicking Save As on the Offi ce But-
ton menu. Then, fi ll in the Save As 
dialog box as described in Steps 2 
through 5 on pages EX 31 and 
EX 32. 

Figure 1–85

Save 
button

Excel saves workbook 
with same fi le name, 
Walk and Rock Music 
1st Quarter Sales

Other Ways

1. Press CTRL+S or press 
SHIFT+F12, press ENTER

Printing a Worksheet
After you create a worksheet, you often want to print it. A printed version of the worksheet 
is called a hard copy or printout. Printed copies of your worksheet can be useful for the 
following reasons:

• Many people prefer proofreading a hard copy of the worksheet rather than viewing 
the worksheet on the screen to check for errors and readability.

• Someone without computer access can view the worksheet’s content.
• Copies can be distributed as handouts to people during a meeting or presentation.
• Hard copies can serve as reference material if your storage medium is lost or 

becomes corrupted and you need to recreate the worksheet. 
It is a good practice to save a workbook before printing it, in the event you experi-

ence diffi culties with the printer.

Q
&

A

Conserving Ink 
and Toner 
You can print a 
presentation in black and 
white to conserve ink 
or toner by clicking the 
Offi ce Button, pointing 
to Print on the Offi ce 
Button menu, and then 
clicking Print Preview on 
the Print submenu. Click 
the Options button on 
the Print Preview tab, 
point to Color/Grayscale 
on the Options button 
menu, and then click Pure 
Black and White on the 
Color/Grayscale submenu. 
Click the Offi ce Button, 
point to Print, and then 
click Quick Print.

B
T
W
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1
• Click the Offi ce 

Button to display the 
Offi ce Button menu.

• Point to Print on the 
Offi ce Button menu 
to display 
the Print 
submenu 
(Figure 1–86).

Print 
button

Offi ce 
Button 
menu

Print 
submenu

To Print a Worksheet

With the completed worksheet saved, you may want to print it. The following steps print the worksheet in the 
saved Walk and Rock Music 1st Quarter Sales workbook.

Figure 1–86

Offi ce Button

2
• Click Quick Print on 

the Print submenu to 
print the document  
(Figure 1-87).

Can I print my 
document in black 
and white to conserve 
ink or toner? 

Yes. Click the Offi ce 
Button and then 
click the Excel 
Options button on 
the Offi ce Button 
menu. When the 
Excel Options dialog 
box is displayed, click 
Advanced, scroll to 
the Print area, place 
a check mark in the 
Use draft qual-
ity check box if it is 
displayed, and then 
click the OK button. 
Click the Offi ce 
Button, point to 
Print, and then click 
Quick Print. 

Figure 1–87

Q
&

A

Other Ways

1. Press CTRL+P, press ENTER
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Quitting Excel
When you close a workbook, if you have made changes to a workbook since the last time 
the fi le was saved, Excel displays a dialog box asking if you want to save the changes you 
made to the fi le before it closes that window. The dialog box contains three buttons with 
these resulting actions:

• Yes button — Saves the changes and then quits Excel
• No button — Quits Excel without saving changes
• Cancel button — Closes the dialog box and redisplays the worksheet without saving 

the changes
If no changes have been made to an open workbook since the last time the fi le was 

saved, Excel will close all windows without displaying any dialog boxes.

To Quit Excel

The Walk and Rock 1st Quarter Sales worksheet is complete. The following steps quit Excel if only 
one workbook is open.

1
• Point to the Close 

button on the right 
side of the Excel title 
bar (Figure 1–88).

Figure 1–88

Close 
button 

2
• Click the Close 

button to quit Excel.

Why are there two 
Minimize and Restore 
buttons in the 
Microsoft Excel 
window? 

You can see that the 
Excel window includes 
two Minimize and 
two Restore icons 
(Figure 1–88). The 
Minimize button and 
Restore button on 
the title bar are used to 
minimize and restore the entire Excel window. The Minimize button and Restore button next to 
the Help icon are used to minimize and restore the worksheet within the Excel window. 

Q
&

A

Other Ways

1. Double-click Offi ce Button

2. Click Offi ce Button, 
click Exit Excel on Offi ce 
Button menu

3. Right-click Microsoft 
Excel button on 
Windows taskbar, click 
Close on shortcut menu

4. Press ALT+F4
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Starting Excel and Opening a Workbook
Once you have created and saved a workbook, you may need to retrieve it from your 
storage medium. For example, you might want to revise a worksheet or reprint it. Opening 
a workbook requires that Excel is running on your computer.

To Start Excel

The following steps, which assume Windows is running, start Excel.
1  Click the Start button on the Windows taskbar to display the Start menu.

2   Point to All Programs on the Start menu to display the All Programs submenu and then 
point to Microsoft Offi ce in the All Programs submenu to display the Microsoft Offi ce sub-
menu.

3   Click Microsoft Offi ce Excel 2007 on the Microsoft Offi ce submenu to start Excel and display 
a new blank worksheet in the Excel window.

4   If the Excel window is not maximized, click the Maximize button on its title bar to maximize 
the window.

To Open a Workbook from Excel

Earlier in this chapter, you saved your workbook on a USB fl ash drive using the fi le name, Walk and Rock Music 
1st Quarter Sales. The following steps open the Walk and Rock Music 1st Quarter Sales fi le from the USB fl ash drive.

1
• With your USB fl ash drive connected 

to one of the computer’s USB ports, 
click the Offi ce Button to display 
the Offi ce Button menu 
(Figure 1–89).

What fi les are shown in the Recent 
Documents list? 

Excel displays the most recently 
opened document 
fi le names in this 
list. If the name of 
the fi le you want 
to open appears in the Recent 
Documents list, you could 
double-click it to open the fi le. 

Figure 1–89

Offi ce Button

Open 
command

Offi ce Button 
menu

Recent Documents 
list displays names 
of recently opened 
Excel fi les

blank Book1 opened in 
Microsoft Excel window

Q
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Print Preview 
You can preview the 
printout on your screen 
using the Print Preview 
command on the Print 
submenu (Figure 1–86 
on page EX 58), make 
adjustments to the 
worksheet, and then 
print it only when it 
appears exactly as you 
want. Each time you 
preview rather than 
print, you save both ink 
and paper.

B
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2
• Click Open on the Offi ce Button 

menu to display the Open 
dialog box.

• If necessary, click the Look in box 
arrow and then click UDISK 2.0 (E:) 
to select the USB fl ash drive, Drive E 
in this case, in the Look in list as the 
new open location.

• Click Walk and Rock Music 
1st Quarter Sales to select the fi le 
name (Figure 1–90).

How do I open the fi le if I am not 
using a USB fl ash drive? 

Use the same process, but be 
certain to select your device in the 
Look in list. 

Figure 1–90

Open 
dialog box

USB fl ash
drive is 
selected device

selected fi le

Look in 
box arrow

Open 
button

Q
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3
• Click the Open button to open 

the selected fi le and display the 
worksheet in the Excel window 
(Figure 1–91).

Why do I see the Microsoft Excel 
icon and name on the Windows 
taskbar? 

When you open an Excel fi le, the 
application name (Microsoft Excel) 
is displayed on a selected button 
on the taskbar. If you point to this 
button, the fi le name also appears 
in a ScreenTip. 

Figure 1–91

Microsoft Excel 
program button 
is displayed on 
Windows taskbar

title of saved 
workbook is 
displayed on 
title bar

worksheet 
appears 

Other Ways

1. Click Offi ce Button, 
double-click fi le 
name in Recent 
Documents list

2. Press CTRL+O, select fi le 
name, press ENTER

Q
&

A
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Figure 1–92

selected 
range is
B6:F6

AutoCalculate area

Maximum 
command

calculated values 
appear on 
shortcut menu

AutoCalculate area 
on status bar

AutoCalculate
You easily can obtain a total, an average, or other information about the numbers in a 
range by using the AutoCalculate area on the status bar. First, select the range of cells 
containing the numbers you want to check. Next, right-click the AutoCalculate area to 
display the Status Bar Confi guration shortcut menu (Figure 1–92). The check mark to the 
left of the active functions (Average, Count, and Sum) indicates that the sum, count, and 
average of the selected range are displayed in the AutoCalculate area on the status bar. 
The functions of the AutoCalculate commands on the Status Bar Confi guration shortcut 
menu are described in Table 1–4.

Table 1–4 AutoCalculate Shortcut Menu Commands

Command Function

Average AutoCalculate area displays the average of the numbers in the selected range

Count AutoCalculate area displays the number of nonblank cells in the selected range

Numerical Count AutoCalculate area displays the number of cells containing numbers in the selected range

Minimum AutoCalculate area displays the lowest value in the selected range

Maximum AutoCalculate area displays the highest value in the selected range

Sum AutoCalculate area displays the sum of the numbers in the selected range 

To Use the AutoCalculate Area to Determine a Maximum

The following steps show how to display the largest quarterly sales for any region for the Micro product type. 

1
• Select the range B6:F6 

and then right-click the 
AutoCalculate area on the 
status bar to display the 
Status Bar Confi guration 
shortcut menu (Figure 1–92).

What is displayed on the 
Status Bar Confi guration 
shortcut menu? 

This shortcut menu includes 
several commands that 
allow you to control the items 
displayed on the Customize 
Status Bar shortcut menu. The 
AutoCalculate area of the 
shortcut menu includes six 
commands as well as the result 
of the associated calculation 
on the right side of the menu. 

Q
&
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Customize 
Status Bar 
shortcut menu

AutoCalculate 
Use the AutoCalculate 
area on the status bar 
to check your work 
as you enter data in a 
worksheet. If you enter 
large amounts of data, 
you select a range of 
data and then check 
the AutoCalculate area 
to provide insight into 
statistics about the data 
you entered. Often, you 
will have an intuitive feel 
for whether the numbers 
are accurate or if you 
may have made a mistake 
while entering the data.

B
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2
• Click Maximum on the shortcut 

menu to display the Maximum 
value in the range B6:F6 in the 
AutoCalculate area of the 
status bar.

• Click anywhere on the worksheet to 
cause the shortcut menu to 
disappear (Figure 1–93).

Figure 1–93

selected 
range is
B6:F6

AutoCalculate area 
displays maximum 
value in range
B6:F6 (92,716.32)

3
• Right-click the AutoCalculate 

area and then click Maximum on 
the shortcut menu to cause the 
Maximum value to no longer 
appear in the AutoCalculate area.

Correcting Errors
You can correct errors on a worksheet using one of several methods. The method you 
choose will depend on the extent of the error and whether you notice it while typing the 
data or after you have entered the incorrect data into the cell.

Correcting Errors while You Are Typing Data into a Cell
If you notice an error while you are typing data into a cell, press the BACKSPACE 

key to erase the incorrect characters and then type the correct characters. If the error is a 
major one, click the Cancel box in the formula bar or press the ESC key to erase the entire 
entry and then reenter the data from the beginning.

Correcting Errors after Entering Data into a Cell
If you fi nd an error in the worksheet after entering the data, you can correct the 

error in one of two ways:
1. If the entry is short, select the cell, retype the entry correctly, and then click the 

Enter box or press the ENTER key. The new entry will replace the old entry.
2. If the entry in the cell is long and the errors are minor, using Edit mode may be a 

better choice than retyping the cell entry. Use the Edit mode as described below.
 a.  Double-click the cell containing the error to switch Excel to Edit mode. In 

Edit mode, Excel displays the active cell entry in the formula bar and a fl ashing 
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insertion point in the active cell (Figure 1–94). With Excel in Edit mode, you 
can edit the contents directly in the cell — a procedure called in-cell editing. 

 b. Make changes using in-cell editing, as indicated below.
 (1)  To insert new characters between two characters, place the insertion point 

between the two characters and begin typing. Excel inserts the new characters 
at the location of the insertion point.

 (2)  To delete a character in the cell, move the insertion point to the left of 
the character you want to delete and then press the DELETE key or place 
the insertion point to the right of the character you want to delete and then 
press the BACKSPACE key. You also can use the mouse to drag through the 
character or adjacent characters you want to delete and then press the 
DELETE key or click the Cut button on the Standard toolbar.

 (3)  When you are fi nished editing an entry, click the Enter box or press the 
ENTER key.

Figure 1–94

contents of cell 
B3 appear in 
formula bar

insertion point 
displayed in cell after 
double-clicking

When Excel enters the Edit mode, the keyboard usually is in Insert mode. In Insert 
mode, as you type a character, Excel inserts the character and moves all characters to the 
right of the typed character one position to the right. You can change to Overtype mode 
by pressing the INSERT key. In Overtype mode, Excel overtypes, or replaces, the character 
to the right of the insertion point. The INSERT key toggles the keyboard between Insert 
mode and Overtype mode.

While in Edit mode, you may have reason to move the insertion point to various 
points in the cell, select portions of the data in the cell, or switch from inserting charac-
ters to overtyping characters. Table 1–5 summarizes the more common tasks used during 
in-cell editing.

In-Cell Editing 
An alternative to double-
clicking the cell to edit it 
is to select the cell and 
then press the F2 key. 

B
T
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Editing the Contents 
of a Cell 
Rather than using in-cell 
editing, you can select 
the cell and then click the 
formula bar to edit the 
contents. 

B
T
W
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Table 1–5 Summary of In-Cell Editing Tasks

Task Mouse Keyboard

1 Move the insertion point to the 
beginning of data in a cell.

Point to the left of the fi rst character and click. Press HOME

2 Move the insertion point to the 
end of data in a cell.

Point to the right of the last character and click. Press END

3 Move the insertion point 
anywhere in a cell.

Point to the appropriate position and click the 
character. 

Press RIGHT ARROW or 
LEFT ARROW

4 Highlight one or more adjacent 
characters.

Drag the mouse pointer through adjacent 
characters.

Press SHIFT+RIGHT ARROW 
or SHIFT+LEFT ARROW

5 Select all data in a cell. Double-click the cell with the insertion point in 
the cell.

6 Delete selected characters. Click the Cut button on the Standard toolbar. Press DELETE

7 Delete characters to the left of 
the insertion point.

Press BACKSPACE

8 Delete characters to the right of 
the insertion point.

Press DELETE 

9 Toggle between Insert and 
Overtype modes.

Press INSERT

Undoing the Last Cell Entry
Excel provides the Undo command on the Quick Access Toolbar (Figure 1–95), 

which allows you to erase recent cell entries. Thus, if you enter incorrect data in a cell and 
notice it immediately, click the Undo button and Excel changes the cell entry to what it 
was prior to the incorrect data entry.

Figure 1–95

Undo 
button

Undo
button
arrow

Redo 
button

Undo list 
contains 
recent actions

Select All 
button

Excel remembers the last 100 actions you have completed. Thus, you can undo up to 
100 previous actions by clicking the Undo button arrow to display the Undo list and then 
clicking the action to be undone (Figure 1–95). You can drag through several actions in the 
Undo list to undo all of them at once. If no actions are available for Excel to undo, then 
the Undo button is dimmed and inoperative.

The Redo button, next to the Undo button on the Quick Access Toolbar, allows you 
to repeat previous actions. 

Clear 
button
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Clearing a Cell or Range of Cells
If you enter data into the wrong cell or range of cells, you can erase, or clear, the 

data using one of the fi rst four methods listed below. The fi fth method clears the 
formatting from the selected cells.

TO CLEAR CELL ENTRIES USING THE FILL HANDLE

1. Select the cell or range of cells and then point to the fi ll handle so the mouse pointer 
changes to a cross hair.

2. Drag the fi ll handle back into the selected cell or range until a shadow covers the cell or 
cells you want to erase. Release the mouse button.

TO CLEAR CELL ENTRIES USING THE SHORTCUT MENU

1. Select the cell or range of cells to be cleared.
2. Right-click the selection.
3. Click Clear Contents on the shortcut menu.

TO CLEAR CELL ENTRIES USING THE DELETE KEY

1. Select the cell or range of cells to be cleared.
2. Press the DELETE key.

TO CLEAR CELL ENTRIES AND FORMATTING USING THE CLEAR BUTTON

1. Select the cell or range of cells to be cleared.
2. Click the Clear button on the Home tab (Figure 1–95 on the previous page).
3. Click Clear Contents on the menu.

TO CLEAR FORMATTING USING THE CELL STYLES BUTTON

1. Select the cell or range of cells from which you want to remove the formatting.
2. Click the Cell Styles button on the Home tab and point to Normal.
3. Click Normal in the Live Preview Gallery.

The Clear button on the Home tab is the only command that clears both the cell 
entry and the cell formatting. As you are clearing cell entries, always remember that you 
should never press the SPACEBAR to clear a cell. Pressing the SPACEBAR enters a blank charac-
ter. A blank character is text and is different from an empty cell, even though the cell may 
appear empty.

Clearing the Entire Worksheet
If required worksheet edits are extremely extensive, you may want to clear the entire 

worksheet and start over. To clear the worksheet or delete an embedded chart, use the 
following steps.

TO CLEAR THE ENTIRE WORKSHEET

1. Click the Select All button on the worksheet (Figure 1–95).
2. Click the Clear button on the Home tab to delete both the entries and formats.

Quick Reference 
For a table that lists how 
to complete the tasks 
covered in this book 
using the mouse, Ribbon, 
shortcut menu, and 
keyboard, see the Quick 
Reference Summary at 
the back of this book, or 
visit the Excel 2007 Quick 
Reference Web page 
(scsite.com/ex2007/qr).

B
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Certifi cation 
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you 
to obtain a valuable 
industry credential 
– proof that you have the 
Excel 2007 skills required 
by employers. For 
more information, see 
Appendix F or visit the 
Excel 2007 Certifi cation 
Web page (scsite.com/
ex2007/cert).

B
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Getting Back to 
Normal 
If you accidentally assign 
unwanted formats to a 
range of cells, you can 
use the Normal cell style 
selection in the Cell 
Styles gallery. Click Cell 
Styles on the Home tab 
on the Ribbon and then 
click Normal. Doing so 
changes the format to 
Normal style. To view 
the characteristics of the 
Normal style, right-click 
the style in the Cell 
Styles gallery and then 
click Modify, or press 
ALT+APOSTROPHE (‘).

B
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The Select All button selects the entire worksheet. Instead of clicking the Select All 
button, you also can press CTRL+A. To clear an unsaved workbook, click the workbook’s 
Close Window button or click the Close command on the Offi ce Button menu. Click the 
No button if the Microsoft Excel dialog box asks if you want to save changes. To start a 
new, blank workbook, click the New command on the Offi ce Button menu.

To delete an embedded chart, complete the following steps.

TO DELETE AN EMBEDDED CHART

1. Click the chart to select it.
2. Press the DELETE key.

Excel Help
At any time while using Excel, you can fi nd answers to questions and display information 
about various topics through Excel Help. This section introduces you to Excel Help. 

To Search for Excel Help

Using Excel Help, you can search for information based on phrases such as save a workbook or format a chart, 
or key terms such as copy, save, or format. Excel Help responds with a list of search results displayed as links to a 
variety of resources. The following steps, which use Excel Help to search for information about formatting a chart, 
assume you are connected to the Internet.

1
• Click the Microsoft Offi ce Excel 

Help button near the upper-right 
corner of the Excel window to 
open the Excel Help window.

• Type format a chart in the Type 
words to search for text box at 
the top of the Excel Help window 
(Figure 1–96).

Excel Help window 
allows you to search for 
information based on 
phrases or key terms

Maximize 
button

Microsoft Offi ce 
Excel Help button

Type words 
to search for 
text box

Figure 1–96

Excel Help 
The best way to become 
familiar with Excel Help is 
to use it. Appendix C
includes detailed 
information about 
Excel Help and exercises 
that will help you gain 
confi dence in using it.

B
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2
• Press the ENTER key to display the 

search results. 

• Click the Maximize button on 
the Excel Help window title bar 
to maximize the Help window 
(Figure 1–97).

Where is the Excel window with 
the Walk and Rock Music 
1st Quarter Sales worksheet? 

Excel is open in the background, 
but the Excel Help window is 
overlaid on top of 
the Microsoft Excel 
window. When the 
Excel Help window is 
closed, the worksheet 
will reappear. 

Excel Help 
window 
maximized

clicking these links 
will display other 
pages with links about 
formatting a chartfi rst 25 results 

of search are 
displayed

search results 
display different 
icons, depending 
on type of link

Microsoft Excel window 
in background

Format chart 
elements link

Q
&

A

Figure 1–97

3
• Click the Format 

chart elements link 
to display information regard-
ing formatting chart elements 
(Figure 1–98).

What is the purpose of the 
buttons at the top of the Excel 
Help window?  

Use the buttons in the upper-left 
corner of the Excel Help window 
to navigate through the Help sys-
tem, change the display, show the 
Excel Help table of contents, and 
print the contents of the window. 

4
• Click the Close button on the Excel Help window title bar to close the Excel Help window and 

make Excel active.

Figure 1–98

Back, Forward, 
Stop, Refresh, and 
Home buttons Print button

Close 
button

Show 
All link 

Help topic links will 
expand, or display 
additional information, 
if you click Show All 
link in this window

Other Ways

1. Press F1 

Q
&

A
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 1. Start Excel (EX 6)
 2. Enter the Worksheet Titles (EX 17)
 3. Enter Column Titles (EX 19)
 4. Enter Row Titles (EX 21)
 5. Enter Numbers (EX 23)
 6. Sum a Column of Numbers (EX 25)
 7. Copy a Cell to Adjacent Cells in a Row (EX 27)
 8. Determine Multiple Totals at the Same Time 

(EX 28)
 9. Save a Workbook (EX 30)
 10. Change a Cell Style (EX 35)
 11. Change the Font Type (EX 36)
 12. Bold a Cell (EX 38)
 13. Increase the Font Size of a Cell Entry (EX 38)
 14. Change the Font Color of a Cell Entry (EX 39)
 15. Center Cell Entries across Columns by Merging 

Cells (EX 40)
 16. Format Column Titles and the Total Row (EX 42)
 17. Format Numbers in the Worksheet (EX 44)
 18. Adjust the Column Width (EX 46)
 19. Use the Name Box to Select a Cell (EX 47)

 20. Add a 3-D Clustered Column Chart to the 
Worksheet (EX 50)

 21. Change Document Properties (EX 55)
 22. Save an Existing Workbook with the Same File 

Name (EX 58)
 23. Print a Worksheet (EX 58)
 24. Quit Excel (EX 59)
 25. Open a Workbook from Excel (EX 60)
 26. Use the AutoCalculate Area to Determine a 

Maximum (EX 62)
 27. Clear Cell Entries Using the Fill Handle (EX 66)
 28. Clear Cell Entries Using the Shortcut Menu 

(EX 66)
 29. Clear Cell Entries Using the DELETE Key (EX 66)
 30. Clear Cell Entries and Formatting Using the Clear 

Button (EX 66)
 31. Clear Formatting Using the Cell Styles Button  

(EX 66)
 32. Clear the Entire Worksheet (EX 66)
 33. Delete an Embedded Chart (EX 67)
 34. Search for Excel Help (EX 67)

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.

To Quit Excel

The following steps quit Excel.

1   Click the Close button on the right side of the title bar to quit Excel. 

2    If necessary, click the No button in the Microsoft Offi ce Excel dialog box so that any changes 
you have made are not saved.

Chapter Summary   EX 69

Quitting Excel 
Do not forget to remove 
your USB fl ash drive 
from the USB port after 
quitting Excel, especially 
if you are working in a 
laboratory environment. 
Nothing can be more 
frustrating than leaving 
all of your hard work 
behind on a USB fl ash 
drive for the next user.

B
T
W

Chapter Summary
In this chapter you have learned about the Excel window, how to enter text and numbers to create a worksheet, how 
to select a range, how to use the Sum button, save a workbook, format cells, insert a chart, print a worksheet, quit 
Excel, and use Excel Help. The items listed below include all the new Excel skills you have learned in this chapter.
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EX 70   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

Learn It Online

Test your knowledge of chapter content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and 
then enter the Web address scsite.com/ex2007/learn. When the Excel 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content. 

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions. 

Practice Test
A series of multiple choice questions that test 
your knowledge of chapter content and key terms. 

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter. 

Apply Your Knowledge

Reinforce the skills and apply the concepts you learned in this chapter.

Changing the Values in a Worksheet
Instructions: Start Excel. Open the workbook Apply 1-1 Bicycle Shop 3rd Quarter Sales (Figure 1–99a). 
See the inside back cover of this book for instructions for downloading the Data Files for Students, or 
see your instructor for information on accessing the fi les required in this book.
 1. Make the changes to the worksheet described in Table 1–6 so that the worksheet appears as shown 

in Figure 1–99b. As you edit the values in the cells containing numeric data, watch the totals in 
row 8, the totals in column G, and the chart change. 

 2. Change the worksheet title in cell A1 to the Title cell style and then merge and center it across 
columns A through G. Use commands in the Font group on the Home tab on the Ribbon to change 
the worksheet subtitle in cell A2 to 16-point Corbel red, bold font and then center it across columns A 
through G. Use the Accent 1 theme color (column 5, row 1 on the Font palette) for the red font color.

 3. Update the document 
properties with your name, 
course number, and name 
for the workbook. Save the 
workbook using the fi le name, 
Apply 1-1 Spoke-Up Bicycle 
Shop 3rd Quarter Sales. 
Submit the assignment as 
requested by your instructor.

Table 1–6 New Worksheet Data

Cell Change Cell Contents To

A1 Spoke-Up Bicycle Shop

B4 11869.2

E4 9157.83

D6 5217.92

F6 6239.46

B7 3437.64
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(a) Before

(b) After

Figure 1–99
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EX 72   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Formatting Cells and Inserting Multiple Charts
Instructions: Start Excel. Open the workbook Extend 1-1 Pack-n-Away Shipping. See the inside back 
cover of this book for instructions for downloading the Data Files for Students, or see your instructor 
for information on accessing the fi les required in this book. Perform the following tasks to format cells 
in the worksheet and to add two charts to the worksheet.
 1. Use the commands in the Font group on the Home tab on the Ribbon to change the font of the title in 

cell A1 to 24-point Arial, red, bold and subtitle of the worksheet to 16-point Arial Narrow, blue, bold. 

 2. Select the range A3:E8, click the Insert tab on the Ribbon and then click the More button in the lower-
right corner of the Charts group on the Ribbon to open the Insert Chart dialog box (Figure 1–100).

Figure 1–100

Stacked Line 
chart type

3-D Area 
chart type

 3. Insert a Stacked Line chart by clicking the Stacked Line chart in the gallery and then clicking the 
OK button. Move the chart either below or to the right of the data in the worksheet. Click the 
Design tab and apply a chart style to the chart.

 4. With the same range selected, follow Step 3 above to insert a 3-D Area chart in the worksheet. 
You may need to use the scroll box on the right side of the Insert Chart dialog box to view the Area 
charts in the gallery. Move the chart either below or to the right of the data so that each chart does 
not overlap the Stacked Line chart. Choose a different chart style for this chart than the one you 
selected for the Stacked Line chart.
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 5. Resize each chart so that each snaps to the worksheet gridlines. Make certain that both charts are 
visible with the worksheet data without the need to scroll the worksheet.

 6. Update the document properties with your name, course number, and name for the workbook.

 7. Save the workbook using the fi le name, Extend 1-1 Pack-n-Away Shipping Charts. Submit the 
assignment as requested by your instructor. 

Make It Right

Analyze a workbook and correct all errors and/or improve the design.

Correcting Formatting and Values in a Worksheet
Instructions: Start Excel. Open the workbook Make It Right 1-1 Book Sales. See the inside back cover 
of this book for instructions for downloading the Data Files for Students, or see your instructor for 
information on accessing the fi les required for this book. Correct the following formatting problems 
and data errors (Figure 1–101) in the worksheet, while keeping in mind the guidelines presented in this 
chapter.

 1. Merge and center the worksheet title and subtitle appropriately. 

 2. Format the worksheet title with a cell style appropriate for a worksheet title.

 3. Format the subtitle using commands in the Font group on the Ribbon.

 4. Correct the spelling mistake in cell A1 by changing Bool to Books.

 5. Apply proper formatting to the column headers and total row.

Continued >

Make It Right   EX 73

Figure 1–101

spelling mistake 
in cell A1 

worksheet titles 
not formatted 

column headings 
and total row 
require proper 
formatting 

incorrect total 
in cell E9 

grand total 
does not 
display

chart improperly 
sized and placed 
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EX 74   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

In the Lab

Design and/or create a workbook using the guidelines, concepts, and skills presented in this 
chapter. Labs 1, 2, and 3 are listed in order of increasing diffi culty.

Lab 1: Annual Cost of Goods Worksheet
Problem: You work part-time as a spreadsheet specialist for Kona’s Expresso Coffee, one of the 
up-and-coming coffee franchises in the United States. Your manager has asked you to develop an 
annual cost of goods analysis worksheet similar to the one shown in Figure 1–102.

Make It Right continued

 6. Adjust column sizes so that all data in each column is visible.

 7. Use the SUM function to create the grand total for annual sales.

 8. The SUM function in cell E9 does not sum all of the numbers in the column. Correct this error by 
editing the range for the SUM function in the cell.

 9. Resize and move the chart so that it is below the worksheet data and does not extend past the right 
edge of the worksheet data. Be certain to snap the chart to the worksheet gridlines by holding 
down the ALT key as you resize the chart.

 10. Update the document properties with your name, course number, and name for the workbook. 
Save the workbook using the fi le name, Make It Right 1-1 Eric’s Used Books Annual Sales. Submit 
the assignment as requested by your instructor.

Figure 1–102
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Instructions: Perform the following tasks.
 1. Start Excel. Enter the worksheet title, Kona’s Expresso Coffee, in cell A1 and the worksheet 

subtitle, Annual Cost of Goods, in cell A2. Beginning in row 3, enter the store locations, costs of 
goods, and supplies categories shown in Table 1–7. 

Table 1–7 Kona’s Expresso Coffee Annual Cost of Goods

New York Chicago Denver Seattle San Franscisco

Coffee Beans 34146.39 43253.53 43522.72 53075.94 47654.32

Containers     964.84   1009.97 864.65 1215.39 1429.98

Condiments 21843.43 37627.87   9817.67 12793.47 11565.13

Pastries 47381.28 52420.37 38389.12 23074.84 22805.06

 2. Use the SUM function to determine the totals for each store location, type of supply, and company 
grand total.

 3. Use Cell Styles in the Styles group on the Home tab on the Ribbon to format the worksheet title 
with the Title cell style. Center the title across columns A through G. Do not be concerned if the 
edges of the worksheet title are not displayed.

 4. Use buttons in the Font group on the Home tab on the Ribbon to format the worksheet subtitle to 
14-point Calibri dark blue, bold font and center it across columns A through G.

 5. Use Cell Styles in the Styles group on the Home tab on the Ribbon to format the range A3:G3 
with the Heading 2 cell style, the range A4:G7 with the Accent1 - 20% cell style, and the range 
A8:G8 with the Total cell style. Use the buttons in the Number group on the Home tab on the 
Ribbon to apply the Accounting Number format to the range B4:G4 and the range B8:G8. Use 
the buttons in the Number group on the Home tab on the Ribbon to apply the Comma Style to 
the range B5:G7. Adjust any column widths to the widest text entry in each column.

 6. Select the range A3:F7 and then insert a 3-D Clustered Column chart. Apply the Style 8 chart 
style to the chart. Move and resize the chart so that it appears in the range A10:G22. If the labels 
along the horizontal axis (x-axis) do not appear as shown in Figure 1-102, then drag the right side 
of the chart so that it is displayed in the range A10:H22.

 7. Update the document properties with your name, course number, and name for the workbook.

 8. Save the workbook using the fi le name Lab 1-1 Konas Expresso Coffee Annual Cost of Goods. 

 9. Print the worksheet.

 10. Make the following two corrections to the sales amounts: $9,648.12 for Seattle Condiments 
(cell E6), $12,844.79 for Chicago Pastries (cell C7). After you enter the corrections, the company 
totals in cell G8 should equal $462,135.04.

 11. Print the revised worksheet. Close the workbook without saving the changes.  Submit the 
assignment as requested by your instructor.

In the Lab

Lab 2: Annual Sales Analysis Worksheet
Problem: As the chief accountant for Scissors Offi ce Supply, Inc., you have been asked by the sales 
manager to create a worksheet to analyze the annual sales for the company by location and customer 
type category (Figure 1–103). The offi ce locations and corresponding sales by customer type for the 
year are shown in Table 1–8.

Continued >

In the Lab   EX 75
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EX 76   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

Instructions: Perform the following tasks.
 1. Create the worksheet shown in Figure 1–103 using the data in Table 1–8.

 2. Use the SUM function to determine totals sales for the four offi ces, the totals for each customer 
type, and the company total. Add column and row headings for the totals row and totals column, as 
appropriate.

Table 1–8 Scissors Offi ce Supply Annual Sales

Boston Miami St. Louis Santa Fe

Consumer 206348.81 113861.40   69854.13 242286.82

Small Business 235573.28 133511.24 199158.35 228365.51

Large Business 237317.55 234036.08 126519.10 111773.38

Government 178798.04 144548.80 135470.86 132599.75

Nonprofi t   15180.63   28837.75   63924.48   21361.42

 3. Format the worksheet title with the Title cell style and center it across columns A through F. Use 
the Font group on the Ribbon to format the worksheet subtitle to 16-point Cambria green, and 
bold font. Center the title across columns A through F.

Figure 1–103

In the Lab continued

 4.  Format the range A3:F3 with the Heading 2 cell style, the range A4:F8 with the Accent3 
- 20% cell style, and the range B9:F9 with the Total cell style. Use the Number group on the 
Ribbon to format cells B4:F4 and B9:F9 with the Accounting Number Format and cells B5:F8 
with the Comma Style numeric format.

 5.  Chart the range A3:E8. Insert a 100% Stacked Column chart for the range A3:E8, as shown in 
Figure 1–103, by using the Column button on the Insert tab on the Ribbon. Use the chart location 
A11:F22.
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 6.  Update the document properties with your name, course number, and name for the workbook.

 7.  Save the workbook using the fi le name, Lab 1-2 Scissors Offi ce Supply Annual Sales. Print the 
worksheet.

 8.  Two corrections to the fi gures were sent in from the accounting department. The correct sales 
are $98,342.16 for Miami’s annual Small Business sales (cell C5) and $48,933.75 for 
St. Louis’s annual Nonprofi t sales (cell D8). After you enter the two corrections, the company
total in cell F9 should equal $2,809,167.57. Print the revised worksheet. 

 9.  Use the Undo button to change the worksheet back to the original numbers in Table 1–8. Use 
the Redo button to change the worksheet back to the revised state.

 10.  Close Excel without saving the latest changes. Start Excel and open the workbook saved in 
Step 7. Double-click cell E6 and use in-cell editing to change the Santa Fe annual Large Business 
sales (cell E6) to $154,108.49. Write the company total in cell F9 at the top of the fi rst printout. 
Click the Undo button.

 11.  Click cell A1 and then click the Merge and Center button to split cell A1 into cells A1, B1, 
C1, D1, E1, and F1. To merge the cells into one again, select the range A1:F1 and then click the 
Merge and Center button on the Home tab on the Ribbon.

 12. Close the workbook without saving the changes. Submit the assignment as requested by your 
instructor. 

In the Lab

Lab 3: College Cost and Financial Support Worksheet
Problem: Attending college is an expensive proposition and your resources are limited. To plan for 
your four-year college career, you have decided to organize your anticipated resources and costs in a 
worksheet. The data required to prepare your worksheet is shown in Table 1–9.

Continued >

In the Lab   EX 77

Table 1–9 College Cost and Resources

Cost Freshman Sophomore Junior Senior

Books   450.00   477.00   505.62   535.95

Room & Board 7500.00 7950.00 8427.00 8932.62

Tuition 8200.00 8692.00 9213.52 9766.33

Entertainment 1325.00 1404.50 1488.77 1578.10

Miscellaneous   950.00 1007.00 1067.42 1131.47

Clothes   725.00   768.50   814.61   863.49

Financial Support Freshman Sophomore Junior Senior

Job 3400.00 3604.00 3820.24 4049.45

Savings 4350.00 4611.00 4887.66 5180.92

Parents 4700.00 4982.00 5280.92 5597.78

Financial Aid 5500.00 5830.00 6179.80 6550.59

Other 1200.00 1272.00 1348.32 1429.22
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EX 78   Excel Chapter 1   Creating a Worksheet and an Embedded Chart

Instructions Part 1: Using the numbers in Table 1–9, create the worksheet shown in columns A 
through F in Figure 1–104. Format the worksheet title as Calibri 24-point bold red. Merge and center 
the worksheet title in cell A1 across columns A through F. Format the worksheet subtitles in cells A2 
and A11 as Calibri 16-point bold green. Format the ranges A3:F3 and A12:F12 with the Heading 2 cell 
style, the ranges A4:F9 and A13:F17 with the Accent 1 - 20% style, and the ranges A10:F10 and A18:
F18 with the Total cell style. 

Update the document properties, including the addition of at least one keyword to the proper-
ties, and save the workbook using the fi le name, Lab 1-3 Part 1 College Cost and Financial Support. 
Print the worksheet.  Submit the assignment as requested by your instructor.

After reviewing the numbers, you realize you need to increase manually each of the Junior-year 
expenses in column D by $600. Change the Junior-year expenses to refl ect this change. Manually change the 
fi nancial aid for the Junior year by the amount required to cover the increase in costs. The totals in cells F10 
and F18 should equal $87,373.90. Print the worksheet. Close the workbook without saving changes. 

Instructions Part 2: Open the workbook Lab 1-3 Part 1 College Cost and Financial Support. Insert an 
Exploded pie in 3-D chart in the range G3:K10 to show the contribution of each category of cost for the 
Freshman year. Chart the range A4:B9 and apply the Style 8 chart style to the chart. Add the Pie chart title 
as shown in cell G2 in Figure 1–104. Insert an Exploded pie in 3-D chart in the range G12:K18 to show 
the contribution of each category of fi nancial support for the Freshman year. Chart the range A13:B17 and 
apply the Style 8 chart style to the chart. Add the Pie chart title shown in cell G11 in Figure 1–104. Update 
the identifi cation area with the exercise part number and save the workbook using the fi le name, Lab 1-3 
Part 2 College Cost and Financial Support. Print the worksheet. Submit the assignment as requested by your 
instructor.

Instructions Part 3: Open the workbook Lab 1-3 Part 2 College Cost and Financial Support. A close 
inspection of Table 1–9 shows that both cost and fi nancial support fi gures increase 6% each year. Use 
Excel Help to learn how to enter the data for the last three years using a formula and the Copy and 
Paste buttons on the Home tab on the Ribbon. For example, the formula to enter in cell C4 is =B4*1.06. 
Enter formulas to replace all the numbers in the range C4:E9 and C13:E17. If necessary, reformat the 

In the Lab continued

Figure 1–104

C6160_EXC_01.4c.indd   78C6160_EXC_01.4c.indd   78 3/6/07   3:26:46 PM3/6/07   3:26:46 PM



Ex
ce

l 
C

h
ap

te
r 

1
S

T
U

D
E

N
T
  

A
S

S
IG

N
M

E
N

T
S

tables, as described in Part 1. The worksheet should appear as shown in Figure 1–104, except that 
some of the totals will be off by 0.01 due to rounding errors. Save the worksheet using the fi le name, 
Lab 1-3 Part 3 College Cost and Financial Support. Print the worksheet. Press CTRL+ACCENT MARK 
( ̀ ) to display the formulas. Print the formulas version. Submit the assignment as requested by your 
instructor. Close the workbook without saving changes. 

Cases and Places   EX 79

Continued >

Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution. 

• EASIER    •• MORE DIFFICULT

• 1: Design and Create a Workbook to Analyze Yearly Sales
You are working as a summer intern for Hit-the-Road Mobile Services. Your manager has asked you 
to prepare a worksheet to help her analyze historical yearly sales by type of product (Table 1–10). Use 
the concepts and techniques presented in this chapter to create the worksheet and an embedded 3-D 
Clustered Column chart.

Table 1–10 Hit-the-Road Mobile Services Sales

2005  2006  2007  2008

Standard Mobile Phones 87598   99087 129791 188785

Camera Phones 71035   75909   96886 100512

Music Phones 65942   24923   34590   15696

Wireless PDAs 67604   58793   44483   35095

Satellite Radios 15161   27293   34763   43367

Headsets   9549     6264     2600     4048

Other Accessories 47963 108059 100025   62367

• 2: Design and Create a Worksheet and Chart to Analyze a Budget
To estimate the funds needed by your school’s Environmental Club to make it through the upcoming 
year, you decide to create a budget for the club itemizing the expected quarterly expenses. The 
anticipated expenses are listed in Table 1–11. Use the concepts and techniques presented in this 
chapter to create the worksheet and an embedded 3-D Column chart using an appropriate chart style 
that compares the quarterly cost of each expense. Use the AutoCalculate area to determine the average 
amount spent per quarter on each expense. Manually insert the averages with appropriate titles in an 
empty area on the worksheet.

Table 1–11 Quarterly Environmental Club Budget 

Jan – Mar April – June July – Sept Oct – Dec

Meeting Room Rent 300 300 150 450

Copies and Supplies 390 725 325 640 

Travel 450 755 275 850

Refreshments 105   85 215 155

Speaker Fees 200 200     0 500

Miscellaneous 125 110   75 215
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•• 3: Create a 3-D Pie Chart to Analyze Quarterly Revenue
In-the-Villa DVD Rental is a DVD movie rental store. The owner of the store is trying to decide if 
it is feasible to hire more employees during certain times of the year. You have been asked to develop 
a worksheet totaling all the revenue received last year by quarter. The revenue per quarter is: Quarter 1, 
$52,699.23; Quarter 2, $111,244.32; Quarter 3, $70,905.03; and Quarter 4, $87,560.10. Create a 3-D 
Pie chart to illustrate quarterly revenue contribution by quarter. Use the AutoCalculate area to fi nd the 
average, maximum, and minimum quarterly revenue and manually enter them and their corresponding 
identifi ers in an empty area of the worksheet. 

•• 4: Design and Create a Workbook to Analyze Your Field of Interest

Make It Personal
Based on your college major, area of interest, or career, use an Internet search engine or other 
research material to determine the total number of people employed in your chosen fi eld of interest 
in the country over the past fi ve years. For each year, break the yearly number down into two or 
more categories. For example, the number for each year can be broken into management and 
nonmanagement employees. Create an Excel worksheet that includes this data. Place the data in 
appropriate rows and columns for each year and category. Create totals for each row, totals for each 
column, and a grand total. Format the worksheet title, column headings, and data using the concepts 
presented in this chapter. Create a properly formatted 3-D Clustered Cone chart for the data and place 
it below the data in the worksheet. Make certain that years are on the X axis and number of employees 
is on the Y axis.

•• 5: Design and Create a Workbook to Analyze Your School

Working Together
Visit the registrar’s offi ce at your school and obtain data, such as age, gender, and full-time versus 
part-time status, for the students majoring in at least six different academic departments this semester. 
Have each member of your team divide the data into different categories. For example, separate the 
data by: 
 1. Age, divided into four different age groups

 2. Gender, divided into male and female

 3. Status, divided into full-time and part-time
After coordinating the data as a group, have each member independently use the concepts and 

techniques presented in this chapter to create a worksheet and appropriate chart to show the total 
students by characteristics by academic department. As a group, critique each worksheet and have each 
member modify his or her worksheet based on the group recommendations. 

Cases and Places continued
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